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What's New?

The following table describes the sections updated to reflect the new andmodified
features on IPDirector from version 6.0 (compared to version 5.9).

In the user manual, the icon has been added on left margin to highlight information on
new and updated features.

Click the section number (or the description) in the table to jump directly to the
corresponding section.

Section Description

Database Explorer Content

1.1 - 2.1 - 8 Edits are available from the Database Explorer

1.1 - 9.2.2 - 9.2.1 -
9.2 - 9.3

Edits can be put in bins.

2.3.2 - 3.2.2 Clips can be A/V files, audio files, stills, logos and CG templates
for use with the Xedio Character Generator tool.

3.2.4 - 4.1 - 5.3 New concept of light clip for clips not stored on an EVS video
server.
Light clips are displayed in the Clips view and Clip Elements view.

9.2 A bin directory containing a bin is automatically created for each
IPDirector user. It is available from the Bins Tree view.

User Interface

2.1 - 12.7 The Saved Filters pane can be accessed by clicking the Saved
Filters button.

4.6.2 - 4.6.4 Icons for destinations targets may have been customized from the
Remote Installer.

New Functions

6.4 New options are available from the playlist contextual menu or
from the playlist grid contextual menu:
• to convert a playlist to an edit.
• to delete a playlist and the clips corresponding to the playlist

elements.

12.4.1 - 12.4.6 -
12.5.3

An Autocomplete function is available as a help for the capture of
search strings. It is available from theQuick Text Search field and
from free text fields of the grid filters.

12.4.3 Possibility to search for synonyms.

12.5.2 Advanced search on keywords can be performed either from a
Select Filter Condition window or from free text fields, with the
Autocomplete function.
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Section Description

9.6.7 New icons exist for bin rules.

12.4.5 - 12.5.3 Quick Text Search Syntax rules, Free Text Search Syntax rules: a
new operator, corresponding to NOT, is available for search in
Quick Text Search field and in free-text search fields.

12.5.3 Free Text Search Syntax rules: The ? operator can be used for
search in the LSM ID column.

12.5.4 Search in Non Free Text fields: New operators, such as NOT or
AND are available in some Select Filter Condition windows.

13.2 Depending on the EVS server configurations, up to 6 player
channels per server are available for assignment to the Database
Explorer.

X What'sNew?
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1. Introduction

1.1. Product Overview

The Database Explorer is a central point in the IPDirector application to perform search on
all themedia available on the network and to loadmedia by a simple operation such as
drag-and-drop or double-click.

The Database Explorer gives a view on themedia in terms of clips, clip elements,
playlists, edits, timelines, logs or media files. Even the files backed up on removable
drives which have been removed (off-line nearline files) are still listed in the Database
Explorer to allows easily retrieving the drive.

In the Database Explorer, you can access themedia and data, either by using your
knowledge of the "clip hierarchy" methods used in EVS video servers or by using quick or
advanced search techniques.

Bins can be created to organize clips, playlists, edits and timelines and bin rules can be
defined to automatically copy these items within a bin corresponding to a specific applied
filter.

Many operations are possible from the Database Explorer. It must be noted that some of
the operations are directly described in the chapters dedicated to the other modules of
IPDirector.

1.2. Opening Database Explorer

To open the Database Explorer, select the corresponding icon on
the IPDirector Application bar. An instance of a Database Explorer window will open.  It is
possible to openmultiple DB Explorer windows at one time.

IPDirector - Version 6.00 - User Manual - Database Explorer
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2. User Interface

2.1. Overview of the Database Explorer

The Database Explorer window contains themain areas highlighted on the following
screenshot and shortly described in the table below:

The Database Explorer window presents a familiar "Explorer" layout:

• The tree view in the left pane displays various branches with items.

• The element grid in the right pane displays the items included in the selected tree
branch or the results of a search in the Database Explorer.

2 2. User Interface
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Area Description

1. Toolbar The toolbar on the top of the Elements grid provides a series of buttons
mainly for viewing, browsing and playing options, as well as a Tools
menu to define options for the Elements grid display.
See section "Toolbar" on page 4.

2. Tree
View

The Tree view shows the different branches of all the items from the
database content. It can be used to filter items in the Elements grid:
clips, clip elements, playlists, timelines, edits, bins, logs, media files.
Depending on the user rights, the user may see different parts of the
tree.

Note
For most of the users, the Clips, Playlists, Timelines, Edits,
Bins and Logs branches in the Database Explorer tree are the
only ones they may access.
Administrators and users with the necessary permissions can
manipulate clip elements or media files.

See section "Tree View" on page 8 for details on the interface.

3. Elements
Grid

The Elements grid displays all the items included in the selected tree
branch or resulting from a search.
See section "Elements Grid and Search Options" on page 10.
Above the grid, functions to perform quick text or timecode searches, or
advanced searches onmetadata are available.

4. Status
Bar

This area provides information regarding the Database Explorer. These
include: the number of elements (in the currently displayed grid, based
on filters and searches applied), the next clip to be played out
(applicable for playout modes), the Auto-Refreshmode, the association
status with a BEPlay Remote and the DB explorer's associated player
channel.
See section "Status Bar" on page 15.

5. Saved
Filters
Pane

This area provides functions to save applied filters or recall and apply
saved filters to the current search.
See section "Saved Filters Pane" on page 16.

The layout of the Database Explorer can be adapted to users' needs:

• the Saved Filters Pane can be shown by clicking the
button or hidden by clicking the button.

• most of the panes can be enlarged or reduced by moving the intersection line between
them.

IPDirector - Version 6.00 - User Manual - Database Explorer
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2.2. Toolbar

2.2.1. Toolbar Options
The toolbar is located on the top of the Elements grid.

The following table gives a description of the options and buttons located on the toolbar.

Interface Element Description

Tree button: Shows or hides the tree
structure area.

Clicking the arrow to the right of the Tree
button displays amenu allowing the user to
select the tree location in the Database
Explorer window.

View option: displays amenu listing
• additional media types which can be

made visible in the tree view. See section
"View Menu" on page 6.

• the display options for the elements
within the grid.

Print button: used to print the Elements grid
currently displayed.

Browse button. When the Browsemode is
enabled, selecting an element will
automatically load it on the associated player
channel, ready to play.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 108.

4 2. User Interface
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Interface Element Description

Play button. When the Play mode is enabled,
selecting an element will automatically play it
on the associated player channel.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 108.

Auto-Play button. The Auto-Play mode
makes it possible to play a list of elements
one after the other on the associated player
channel, as they are displayed in the
Database Explorer window. The elements
are played without transition effects.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 108.

Photo button: used to grab a thumbnail of the
clip or playlist loaded on the player channel
which is associated to the Database
Explorer.
See section "Photo Button" on page 6.

Refresh button: performs amanual refresh of
the Elements grid.

Tools option: displays a contextual menu
with various options for themanagement of
the Database Explorer operations.
These options are described in "Tools Menu"
on page 7.

Assign button: used to assign keywords to
one or several clips. It can be activated in
Clip, Clip element or bins/clips branches of
the Database Explorer.
See section "How to Assign Keywords to
One or Several Clips" on page 46.
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2.2.2. View Menu
Depending on your user rights, you will be allowed to view different parts of the tree and
somemenu items could be dimmed.

Clicking theView button displays amenu from which the first options allow tomake some
additional media types visible in the tree view. These options are explained in the
following table:

Options related to
the tree view

Description

Show off-line IP
Drive storages

Shows all the off-line files in the interface.
Shows the IP drives storage units wheremedia have been
backed up, even if the drives have been removed. This allows
the user to easily search for archivedmedia information.
All off-line files are displayed in italic gray text in the grid, and
will have amodified File icon with a red border. See section
"Clip Element Types" on page 17 for the list of icons.

Show LoRes tree Available for Administrators/Media Managers or high
resolution/low resolution browsers according to assigned user
rights.
When selected, a low resolution branch appears in the Clips
and Clip Elements branches.
Enables theMediaManager to re-organize XT clips.

Show Clip
Elements plug-in

Available for Administrators/Media Managers or high
resolution/low resolution browsers according to assigned user
rights.
Shows the Clip Elements branch in the tree with sub-branches
for XT clips, on-line and off-line nearline files.
The Elements grid corresponding to the Clip Elements tree
branch is intended to show the clip elements individually.

Show Media Files
plug-in

Available for Administrators/Media Managers or high
resolution/low resolution browsers according to assigned user
rights.
Shows theMedia Files branch of the tree with sub-branches for
on-line and off-line nearline files.
Enables theMediaManager to perform actions on files, such as
delete, move, and analysis of the file discovery status and
errors.

2.2.3. Photo Button
Thumbnail are created automatically by the XMLUnit defined for the Thumbnails for
Clips option in the Remote Installer. Please see the Technical Referencemanual for
further details.

6 2. User Interface
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A thumbnail can also be createdmanually for the clip or the playlist loaded on the player
channel which is associated to the Database Explorer. This is done by clicking thePhoto
button or by pressing theSHIFT+P keyboard shortcut. The thumbnail is grabbed at the
current timecode and replaces the thumbnail previously associated to the clip or playlist.

ThePhoto button is only available when an A/V board has been activated and linked to
the player channel in the Remote Installer. See the Control Panel user manual.

2.2.4. Tools Menu

Option Description

Auto-Refresh
Mode of
Database
Explorer

Selects/de-selects Auto refreshmode for the grid.
When large amounts of data are present, the automatic refresh can
slow down the system. To only refresh the system on demand,
disable this option.

You can do amanual refresh by clicking theRefresh button

Auto-Refresh
in filter mode

Selects/de-selects Auto refreshmode for the grid in Filter mode.

Limit Result
count

When enabled, the Limit Result Count option will limit the results of
any search to the number of elements defined in the IPDirector
Remote Installer (1000 elements by default).
Refer to the Technical ReferenceManual for more information.

Insert mode A submenu proposes the following options:
• First: new items will be inserted at the top of a list
• Last: new items will be inserted at the bottom of a list
• First Display: new items will be inserted at the top of the visible

part of a list
• Sorted: new items will be inserted at their sorted position in a list

Transfer
Monitoring

Transfer monitoring is explained in section "Transfer Monitoring" on
page 43.
Available for administrators and users with appropriate user rights.

My transfer
only

When enabled, this option only shows you the transfers that you
initiated.

Clip Element
Association

Enables tomanually associate a clip element to an existing clip with
matching TC. See section "How toManually Associate a Clip
Element to an Existing Clip" on page 51.
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2.3. Tree View

2.3.1. Introduction
The Database Explorer is presented in a tree structure, much likeWindows Explorer.

OR 

The tree view allows browsing and performing search in the database and nearline
storage. Clicking the arrow next to a tree branch expands it. The selected branch content
is displayed in the Elements grid. See section "Branch Selection in the Database Tree" on
page 84.

Depending on the user rights, the user can see different parts of the tree.

Administrator or MediaManager will have full rights and therefore could be able to see all
the tree branches available.

2.3.2. Tree View Elements
The table below mentions which items are displayed in the Elements grid based on the
tree branch selected.

8 2. User Interface
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Tree Branch Description

Clips The Clips branch is visible by all the users.
It displays the list of clips present in the database and on the
nearline storages in the Elements grid. Each clip is displayed on a
separate line within the Elements grid and the view can be
expanded to display the different clip elements making up the clip.
It also lists the record trains from the servers present on the XNet.
Clips can be A/V files, audio files, stills, logos and CG templates
for use with the Xedio Character Generator tool.
See section "Clips View" on page 25 for more information on the
Clips branch of the tree.

Clip Elements

(not visible for
most users)

It displays the list of clip elements present in the database and on
the nearline storages in the Elements grid. Each clip element is
displayed on a separate line within the Elements grid.
See section "Clip Elements View" on page 47 for more information
on theClip Elements branch of the tree.

Playlists It displays all the playlists present in the database and on the
nearline storages in the Elements grid. Sub-branches list the on-
line and off-line playlists separately.
See section "Playlists View" on page 52 for more information on
thePlaylists branch of the tree.

Timelines It displays timelines present in the database in the Elements grid.
See section "Timelines View" on page 58 for more information on
the Timelines branch of the tree.

Edits It displays all the edits present in the IPDirector database in the
Elements grid. Edits may have been created from the Xedio IPD
Plugin, the Director's Cut module of IPDirector or the IPBrowse
application. Edits can only bemodified from the CleanEdit
interface.

IPDirector - Version 6.00 - User Manual - Database Explorer
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Tree Branch Description

Bins Sub-branches shows the bins and bin directories.
The Elements grid contains four tabs, Clips, Playlists, Timelines
andEdits, to display respectively the clips, playlists, timelines and
edits which have been sent to the selected bin or bin directory.
See section "Bins View" on page 65 for more information on the
Bins branch of the tree.

Logs It displays all the logsin the Elements grid. Sub-branches are
displayed for each logsheet and for any log directory which have
been created.
See section "Logs View" on page 76 for more information on the
Logs branch of the tree.

Media Files
(not visible for
most users)

It displays all the files which have been saved on a nearline
storagein the Elements grid. Sub-branches may be available for
on-line high resolutionmedia files, on-line low resolutionmedia
files, off-line high resolutionmedia files, off-line low resolution
media files.
They are listed with full file name, file extension and full path of
their physical storage location.
See section "Media Files View" on page 81 for more information on
theMedia Files branch of the tree.

2.4. Elements Grid and Search Options

2.4.1. Quick Text Search Area

Introduction

TheQuick Text Search is used to perform a search based on free text entered in the
Quick Text Search field. This field is available on the top of the Elements grid. You can
perform a search on displayed columns or a search on all columns (displayed and hidden
columns).

See section "Quick Text Search" on page 86 for details on the various ways to use this
function.

10 2. User Interface
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Quick Text Search Associated Buttons

The following table gives a description of the buttons located next to theQuick Text
Search field.

Interface
Element

Description

To perform a search on all columns of the Elements grid (even the hidden
ones), you first need to activate theSearch on All Columns option.
This option is accessible from the down arrow next to theSearch button:

See section "Quick Text Search" on page 86 for more information on
quick text searches on displayed or all columns.

Displays the Syntax Rules list. See section "Quick Text Search Syntax
Rules" on page 88.

Clears the applied Quick Text search.

Clear All button: clears all the applied searches.

2.4.2. Quick Timecode Search Area
To display theQuick Timecode Search field, you need to click the down arrow next to
theSearch button and select Display Timecode Search from themenu:

By entering a timecode value in theQuick TC Search field, you can perform a quick
search on a timecode value within the elements displayed in the grid.

See section "Quick Timecode Search" on page 85 for more information on timecode
searches.
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2.4.3. Advanced Search
Advanced Search functions are available for detailed search operations. They allow
searches onmetadata displayed in the grid columns.

TheGrid Filter bar can be displayed just over the Elements grid by clicking theSearch
button above the grid:

To hide the Grid Filter bar, click theSearch button once again.

See section "Advanced Search" on page 92 for more information on grid filters.

2.4.4. Element Grid

Introduction

The Elements grid represents the content of the tree branch selected in the tree view of
the Database Explorer, or it returns the result of a search applied to a selected branch of
the tree view.

Elements are presented in rows and all their associated parameters andmetadata are in
columns. When all of them cannot be displayed in the window, vertical and/or horizontal
scroll bars appear to facilitate further movement.

Elements Grid Header Contextual Menu

Right-clicking the grid header displays the grid contextual menu.

This menumakes it possible to perform the following actions:

Option Description

Hide Hides the selected column.

Organize A popup window is opened allowing the selection of columns to display
and in which order. The same style of window appears as in other
IPDirector displays.

Save grid
organization

Saves the organization of the grid as it is displayed (columns selection,
order and size). It is saved by user. So, this organization will be
retrieved the next time the user logs in and opens the Database
Explorer.

Reset grid
organization

Comes back to the default grid organization.

12 2. User Interface
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Sorting the Elements in the Grid

You can change the sort order of data in a column by clicking the column heading.

The column heading which is used for sorting is highlighted in blue. The little triangle
indicates the sorting order. Clicking the column heading again changes the sorting order
from ascending to descending or vice versa.

Organizing Columns

Columns can be resized and/or re-ordered. This new organization is automatically saved
and remembered. However, it is possible to reset the column organization to default by
right-clicking the column headers area and selectingReset Grid Organization.

Resizing Columns

A column can be resized by using themouse pointer over columns intersection and
dragging it to the right or to the left.

Re-ordering Columns

To change the columns order, proceed in one of the following ways.

Select a column header and drag it to the left or right to the required place:

OR

1. Right-click a column header.

A menu is displayed.

2. Select Organize.

IPDirector - Version 6.00 - User Manual - Database Explorer

2. User Interface 13



A window opens and shows the list of columns in the current order:

3. To select the column(s) you wish to add to the view, do one of the following:

◦ double-click the column(s) you wish to add to the view in the left pane

OR

◦ select them in the left pane and click the right blue arrow

OR

◦ drag them onto the Visible Columns area.

Use CTRL + click to select multiple columns.

Use SHIFT + click to select a range of columns.

4. To select the column(s) you wish to remove from the view, do one of the following:

◦ double-click the column(s) you wish to remove from the view on the right pane

OR

◦ select them in the Visible Columns area on the right pane and click the left blue
arrow

OR

◦ drag them onto the "() Columns" area.

Use CTRL + click to select multiple columns.

Use SHIFT + click to select a range of columns.

5. If you wish to change the display order of a column, you can drag it to a different
position in the Visible Columns pane.

6. Click OK to confirm orCancel to exit without applying the changes.
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2.5. Status Bar

The Status bar contains five areas shortly described in the table below:

Area Description

1. Element
Number
Zone

The first zone of the Status bar shows how many elements are
included in the Elements grid of the Database Explorer.

2. Next Clip
Zone

The second zone shows the next clip (in green) to be played if the
Auto-Play mode is active. The text is orange if the Auto-Play mode is
not active:

3. Auto-
Refresh
Zone

The third zone displays the Auto-Refresh status. Its background is
green when it is ON, or red when it is OFF. See section "Tools Menu"
on page 7.

4. Associated
BEPlay
Remote
Zone

The fourth zone gives indication on the association status to a
BEPlay Remote.

is shownwhen no BEPlay Remote is connected to the IPDirector.

is shownwhen a BEPlay Remote is connected to the IPDirector but it
is not associated to the Database Explorer.

is shownwhen a BEPlay Remote is associated to the Database
Explorer.
To link or unlink a BEPlay remote to a Database Explorer, double-
click the BEPlay Remote zone.
See theGeneral Functions user manual for details on the
configuration and use of the BEPlay remote.

5. Associated
Channel
Zone

The fifth zone shows the associated player channel, if any.
Otherwise, it shows "None". See section "Assigning a Player
Channel to the Database Explorer" on page 108 for more information
on how to assign a player channel.
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2.6. Saved Filters Pane

The Saved Filters pane can be displayed by clicking theSaved Filters button.

With this mode, you can save filters defined in the grid thanks to the quick search fields
and/or the grid filter bar. You can also apply filters previously saved.

See section "Using Saved Filters" on page 105 for more information on the search saving
functions.
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3. Clips, Clip Elements and Nearline
Files

3.1. Terminology

Term Definition

Nearline Any IT storage, other than the EVS video servers, present on the network and
where A/V material can be backed up or from which A/V material can be
retrieved. These IT Storage devices are inventoried into the IPDirector
database.
Examples of nearline storage: IP drive, XFile drive, SAN, NAS…

On-line
nearline

A nearline is displayed as on-line in the database tree when the next two
conditions aremet:
• It is accessible (IP address can be "pinged")
• It is managed by a SynchroDB

On-line
nearline
file

A file stored on an on-line nearline storage and which has been treated by the
SynchroDB.
It can be a high resolution file or a low resolution file.

Off-line
nearline
file

A file stored on an IP drive nearline storage which is nomore on-line, either
because it is no longer accessible or because it is nomoremanaged by a
SynchroDB.
It can be a high resolution file or a low resolution file.

3.2. Notions About Clips

3.2.1. Clip Element Types
A clip is a logical entity that contains A/V media and can include several physical
resources (clips and/or files).

A clip element is the physical resource inside the clip: XT clip or nearline file.

A clip and its clip elements share the same TC IN, TC OUTandmetadata set.

A clip can contain up to six types of clip elements and each of them is identified in the
Elements grid by a distinct icon, as detailed in the table below.
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Clip Element Description

XT high resolution
clip

high resolution clip or growing clip stored on an EVS video
server.

XT low resolution clip low resolution clip or growing clip stored on an EVS video
server.

on-line high
resolution nearline file

high resolution file stored in nearline folders, IP drive is on-
line (accessible andmanaged).

on-line low resolution
nearline file

low resolution files stored in nearline folders, IP drive is on-
line (accessible andmanaged).

off-line high resolution
nearline file

high resolution files stored in nearline folders, IP drive is no
more on-line.

off-line low resolution
nearline file

low resolution files stored in nearline folders, IP drive is no
more on-line.

In the Elements grid, the Clip Elements column shows the icons for the different clip
elements making up the clip.

Depending on user rights, the user can see different element types. The tables in section
"View Menu" on page 6 givemore details on the user rights.

Note
There can be several copies of the same element within a clip.

3.2.2. Clip Content Types
Various clip content types are supported by IPDirector and displayed in the Clips
Elements grid. Some of them are intended to be usedmainly within the CleanEdit
interface.

The Content Type column provides the indication on the content. Those are Audio/Video,
Audio only, Still, Logo and CG Template (for CG templates used with the Xedio Character
Generator tool).

3.2.3. Clip LSM ID

Understanding Clip Structure on an EVS Video
Server

One library method used by IPDirector is to mimic the hierarchical structure adopted by
the EVS range of servers to storemedia, which is based on the remote panel design with
a limited amount of buttons and desk space.

Each EVS video server can store up to 900 clip numbers (with each clip number
containing up to 6 sub clips, lettered A to F).
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900 clips with up to 6 sub-clips per clip result in 5400 "clip registers" in each EVS video
server.

The following diagram represents the hierarchy of the XT clip numbering system. As an
example, clip number "129C" is used:

The number of the EVS video server within the network structure is also added to define
the precise location of the clip. For example if clip 129C is stored on themachine allocated
with the network number 2, the clip would be identified as 129C/02.

The LSM ID is this identificationmade up of page nr + bank nr + position in the bank +
server nr.

Virtual LSM ID / Real LSM ID

Real LSM ID

The real LSM ID reflects the location where a XT high resolution clip or a XT low resolution
clip will be saved, as described in section "Understanding Clip Structure on an EVS Video
Server" on page 18.

In the Elements grid displayed from the Clip Elements view, the real LSM ID is always
mentioned.
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Virtual LSM ID

From the Clips view, a single LSM ID is displayed for a clip. It is called the virtual LSM ID.

• If a XT high resolution clip is present in the clip, it will be the LSM ID of the XT high
resolution clip, ,

• If there is no XT high resolution clip in the clip, this field will be left empty .

When the LSM ID of the XT high resolution clip is changed, the virtual LSM ID is changed
as well.

When the LSM ID of the XT high resolution clip is deleted, the virtual LSM ID is removed
and the LSM ID field is set to blank.

When the LSM ID of the XT high resolution clip appears in a clip, the virtual LSM ID is
updated tomatch.

So, if a XT low resolution clip is present in the clip, the only way its real LSM ID can be
retrieved is from the Clip Elements branch of the tree. This view and function should only
be used by system administrators andmediamanagers.

3.2.4. Normal Clip Versus Light Clip

Purpose

When a lot of users work on IPDirector, they can create a large amount of clips. This can
potentially lead to a situation where toomany XT clips are created on the EVS video
server and where the database is overloaded by resources-consuming processes.

The concept of light clip has been introduced to avoid the creation of a large amount of
clips on an EVS video server. A specific user right is required to be able to create light
clips.

Normal Clip

When a clip is created from a live train, it will be a normal clip, stored on an EVS video
server with a LSM ID.
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Light Clip

When a sub-clip is created from a normal clip, a light clip will be created which contains an
XT clip element. This XT clip element will be stored in the IPDirector database but not on
the EVS video server because it is actually a reference to the original XT clip present on
the server. So, no LSM ID will be associated to the XT clip element from the light clip.

In the example below, the first clip is the normal clip created from the train and the second
clip is the light clip created by trimming the normal clip:

A light clip will not be taken into account in heavy processes such as clip-log auto-
associations, bin filters,…

3.3. Nearline Management

3.3.1. Purpose
XT clips can be sent to a nearline for backup purpose. They are saved on the nearline as
files. Physical storage such as IP drive (or XF drive) can be used as nearline. A clip which
only contains a nearline file can be restored to an EVS video server, for example for
playout purpose.

Once a nearline directory has been configured in the Remote Installer, the IPDirector will
continuously scan the directory path looking for new files or files being deleted. The IP
drive service will also automatically detect the appearance of a new IP drive, or XFile
disk, or the ejection of a drive.

3.3.2. Files Types
All the files appearing on the nearline storage are filtered according to a list of supported
extensions. Depending on the extension, they will or will not be visible in IPDirector.

Files can be classified among three types.

Files with a non-supported extension and which are not video files

They will be ignored and will not be visible in IPDirector.
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This could be an EVS XML file without an associated A/V file or this could be a file with a
non-supported extension like a dll, or a text file.

Files with an extension not supported on the nearline

They will be visible in theMedia Files branch of the tree, but no clip will be created, so
they will not be visible in the Clips branch of the tree for most users.

The import status of this kind of files will be "unsuccessful" in the Import Status column of
theMedia Files node with the error message stating "unsupported format".

In a future version of IPDirector, it will be possible to import these files by initiating a
transcoding process.

Files with an extension supported on the nearline

They will be visible in theMedia Files and in the Clips branches of the tree.

This is the case for EVS MXF, QT, OP1A, Proxy (lo-res) and DV DIFF files.

In addition, somemulti-files formats, having separate files for audio, video, and
sometimes a reference file, are now supported by IPDirector. With such files, IPDirector
links the different components and only one file appears in theMedia Files grid.

This is the case for QT Ref, OPAtom andMPEG 1Elementary System.

Metadata of this third kind of files can be obtained from three different sources which will
be reflected in themetadata source column of theMedia Files node:

Metadata Source Metadata Source Column

XMLmetadata file XML

Header of an EVS MXF file EVS MXF

nometadata None

TheMetadata files are automatically updated when clip metadata are changed.

3.3.3. Error Messages
The following error messages could appear in theError Message column of the Database
Explorer grid:

Error Message Source of the Error

Could not read metadata file Badmetadata file: corrupted file or
bad syntax.

Some compulsory tags are missing from
the XML metadata file

Badmetadata file: missing tag or
incoherent data (e.g. IN < OUT).

Bad data in one or more metadata tag Badmetadata file: bad/incoherent
data (e.g. IN < OUT, bad value).
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Error Message Source of the Error

Unsupported A/V format. You need to
transcode your file before importing it to
IPDirector nearline.

Unsupported A/V format (recognized
by Timecode Extractor but not
supported natively).

Could not read A/V file. This file might be
corrupted or in the wrong format.

Corrupted A/V file. Timecode
Extractor or EVS MXF.dll cannot read
the file.

3.3.4. Supported Codecs
The following codecs can bemanaged by the nearline:

• SD: MJPEGSD, MJPEGProxy, IMX 30, IMX 40, IMX 50, DVCPRO 25, DVCPRO
50, MPEG-1, MPEG-2, MPEG-2 (I-Field), DV25, H-264.

• HD: MJPEGEVS HD, MJPEGStandard HD, MPEG-2, MPEG-2 (I-Field), MPEG-2
HD (I-frame), Avid DNxHD® Lo, DNxHD® Hi 8 bits, DNxHD® Hi 10 bits, DVCPRO
HD 100mbps, XDCAMHD, ProRes 422 SQ, ProRes 422 HQ, ProRes 422 LT, AVC
Intra, H-264, AVC Intra 50, AVC Intra 100.

3.3.5. Off-line Nearline Files

Introduction

Off-line files are displayed in the Database Explorer when theShow off-line files option
is selected from the View menu available on the toolbar.

Display Off-line Clips or Clip Elements

All off-line clips and clip elements are displayed in italic.

A clip is off-line when all its clip elements are off-line.

For example, a clip which contains an off-line high resolution file and an on-line low
resolution XT clip will be on-line, even for "high resolution only" browsers.
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Operations on Off-line Clip or Clip Elements

The following operations are not allowed on off-line clips or clip elements:

• left-click

• right-click

• drag-and-drop

• double-click

• assignmode

• modify assigned keywords

• browsemode

• play mode

3.3.6. Status of Clip / Clip Elements
When a transportable mediamanaged as an IP Drive storage is inserted or removed from
its host, the status of the clip and clip elements is updated automatically:

• the icon in the Clip Element column is updated: / ↔ /

• the text is changed between normal and italic

• operations are allowed or disabled.
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4. Clips View

4.1. Clip Tree Structure

The Clips branch is visible by all the users. Themain branch displays all the clips from the
sub-branches.

Within the Clips tree structure, the following sub-branches are available:

• Physical hardware present on the XNet, such as:

◦ high resolution EVS video servers: displays clips containing a high resolution clip
saved on the high resolution EVS video servers.

Light clips are listed here as well even if they are not saved on a server but only
refer to a normal clip itself saved on a server.

◦ low resolution EVS video servers: displays clips containing a low resolution-clip
saved on the low resolution EVS video servers.

TheShow Lores tree optionmust have been selected from the View contextual
menu.

◦ XF[2] or XStore hosting XFile software: displays clips which have been backed up
to XFile and then published from XFile to the XNet.

Even if an XT clip is backed up to XFile in a file format, when the file is published
from XFile, it appears with aClip icon in the Elements grid.

Eachmachine can be searched by browsing the tree from network number > page >
bank.
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• On-line nearline: displays clips which have been backed up to nearline/IP drive and for
which the nearline/IP drive is still accessible, so clips can still be immediately
retrievable.

• Off-line nearline: displays clips which have been backed up to nearline/IP drive and for
which the nearline/IP drive cannot be accessed anymore. So, IP drive identification
allows clips to be retrieved after re-inserting the drive, for example.

TheShow offline IP Drive storages optionmust have been selected from the View
contextual menu.

4.2. Elements Grid for Clips

4.2.1. Clips Display in the Elements Grid
Clicking the Clips branch of the tree displays the list of clips in the Elements grid. Each
clip is displayed on a separate line within the grid but the view can be expanded thanks to
a small arrow at the beginning of each line. The different clip elements, XT clips and files,
making up the clip are then displayed on separate lines.

The Clips branch also lists the record trains from the servers present on the XNet. They
appear with the same icon as XT high resolution clip.

Sub-branches only display the corresponding clip elements: XT clips for the EVS video
servers sub-branches, files for nearlines.

4.2.2. Clip Data Columns
The clip data is organized in columns. Some of the details can be edited from here, others
are for viewing only. All the column headers can be used as filters when performing a
search.

See section "Organizing Columns" on page 13 for details on how to hide or show the
columns.

Most of the columns are described in the table below:
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Column Name Description

Thumbnail A reference frame from the clip can be shown to identify thematerial
visually.

Key
Thumbnail

A reference frame from the Key clip can be shown relative to the
selected Fill clip.

Name A clip can be automatically named:
• using a configuration setting in the EVS video server
• from the EVS video servers keyboard
• from the IPDirector Control Panel when using it to create clips

Clip Element Displays all the icons corresponding to all the elements included in the
clip.

XT high resolution clip (green icon)
XT low resolution clip (blue icon)
on-line high resolution file (green icon)
on-line low resolution file (blue icon)
off-line high resolution file (green icon surrounded with red line)
off-line low resolution file (blue icon surrounded with red line)

Record trains are also listed with the icon (green icon).

LSM ID This is the virtual LDM ID as explained in section "Virtual LSM ID /
Real LSM ID" on page 19.

UmID UmID is a fixed length 8-character ID. The EVS video server
automatically assigns a UmID each new clip. It is used for the unique
identification of a clip on an XNet network.
Within a clip, the UmID of the XT high resolution clip and the UmID of
the high resolution file are the same.
The UmID displayed is the UmID of the high resolution clip, if any.
Otherwise, it is the UmID of the high resolution file.

VarID VarID is a 32-character ID with variable length and format. It is
automatically assigned to new clips. It is mainly used to ensure
redundancy on the system. It can be unique for a clip on the EVS
video server level or on the XNet network level, depending on the EVS
server settings.
Within a clip, the VarID of the XT high resolution clip and the VarID of
the high resolution file are the same.
The VarID displayed is the VarID of the high resolution clip, if any.
Otherwise, it is the VarID of the high resolution file.

Status Displays the archive status of a clip. See section "Status Icons" on
page 29 for a complete list of all the icons which can be displayed.
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Column Name Description

Protected Displays the protection status of a clip. No icon is displayed if the clip
is not protected.
In hi-lo mode, two icons are present, one for each XT clip.
Icons available are:

high resolution clip protected by the IPDirector protocol
low resolution clip protected by the IPDirector protocol
high resolution clip protected by another protocol
low resolution clip protected by another protocol

See section "Clip Protection" on page 29.

T/C IN The IN timecode of the clip, without guardbands.

T/C OUT TheOUT timecode of the clip, without guardbands.

Duration The clip duration from T/C IN to T/C OUT.

Limit IN The Protect IN timecode of the clip including guardbands.

Limit OUT The Protect OUT timecode of the clip including guardbands.

Keywords A list of the standard keywords that have been associated with the
clip.

Participants A list of the participant keywords that have been associated with the
clip.

Level A rating can be given to a clip, from zero to three stars. This can be
done during clip creation or later on and can provide a useful search
filter for use in the Database Explorer.

None, , ,

Ganged If the clip is linked to other clips, because it has been created on
ganged recorders, the gang icon is displayed

Type If the clip is a Key Clip, a Fill clip or a normal clip.

Creation Date The date when the clip was created.

Source Name The record source name of the channel where the clip was created.
This name is assigned in the EVS video server set upmenus.
The source name is always the one of the high resolution element,
even if the element is off-line. If there is no high resolution element,
the field is empty.

Storage Concatenation of the storage locations of all the clip elements.

Category Category assigned to the clip in the Ingest Scheduler.

Tape ID Tape ID as ingested in the VTR engine or from an AVID system.

SLSM Indicates if a clip is a Super Motion clip or not

Owner Clip owner identification.

Published All the groups the clip has been published to.
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Column Name Description

In Bins Provides the list of bins in which the clip has been inserted.

Profile Provides the list of profile names associated to the clip.

Created in
IPEdit

Mentions whether the clip has been created in IPEdit (YES) or not
(NO)

4.2.3. Status Icons
The table below gives a description for most of the icons which can appear in theStatus
column of the Elements grid.

Icon Description

The clip is still in the process of being sent to a nearline/target.

The clip is still in the process of being sent to CleanEdit application.

The clip is still in the process of being sent to Avid.

The clip is still in the process of being sent to an EVS video server through the
GigE network.

The clip has been successfully sent to a nearline/target.

The clip has been successfully sent to CleanEdit application.

The clip has been successfully sent to Avid.

The clip has been successfully sent to an EVS video server through theGigE
network.

Clip for which the transfer to a nearline/target failed.

Clip for which the transfer to CleanEdit application failed.

Clip for which the transfer to Avid failed.

Clip for which the transfer to an EVS video server through theGigE network
failed.

4.2.4. Clip Protection
You can protect clips from deletion by Multicam users or other IPDirector users. The clip
protection will not prevent other users from deleting the clips. However, it will warn them
that the clip is protected and should not be deleted.

Within IPDirector, you can protect and unprotect a clip mainly from the contextual menus
of the Database Explorer and the Control Panel or during the creation of a clip.
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Note
When you protect a XT hi-res clip, the lo-res version (if present) is protected
automatically and vice versa. Then, two icons will be displayed, one for each XT
clip. The protect feature does not affect hi-res or lo-res files.

If a clip is protected by the IPDirector protocol, the Protect icon (hi-res) or (lo-res)
appears in theProtect column of the element.

If the clip is protected by another protocol, theProtect icon (hi-res) or (lo-res)
appears in theProtect column.

Note
It is possible to protect a clip via IPDirector if it is already protected by another
protocol. This will ensure that the clip remains protected even if it is unprotected
later by the other protocol.
In IPDirector, it is not possible to remove the clip protection defined by another
protocol.

4.2.5. Clip Contextual Menu
The Clip contextual menu is available when right-clicking a clip in the Elements grid. It
gives access to the actions that can be performed on clips in the Database Explorer.

The following table describes the commands from the clip contextual menu:

Command Description

Cut Not relevant in the Elements grid.

Copy Copies the clip to the clipboard. A shortcut to the clip can then be pasted in
a bin.

Paste Not relevant in the Elements grid.

Send To Provides a list of possible destinations to which the selected clip can be
sent.
Possible destinations are:
• the user's default bin
• the user's default playlist
• a default archive target
• any target destination visible on the GigE network that has been

defined, such as CleanEdit targets, Avid, targets, Final Cut Pro
targets, File targets.

Backup to
Nearline

Enables the backup of clip to the default nearline or to a nearline directory.
Lists the on-line nearline directories destinations to which the loaded clip
can be sent.
During the backup process, an XMLmetadata file is generated. In this file,
the keywords assigned to the clip appear in the order they have been
entered by the operator.
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Command Description

Copy by
GigE

Copies a clip from an EVS video server to another one by the way of the
Gigabit network, as far as the servers have aGigE card. Lists all the EVS
video servers that have aGigE address with sub-menus to select server
pages.

Restore to
XT

Restores the clip to an EVS video server.
• the default server.

The default server is defined in the XNet network page of the Remote
Installer.

• one of the EVS video servers with GigE address present.
A submenu is available from each EVS video server to select the
server page where you can restore the clip.

Publish Opens the Publish Clip window from which the selected clip, or clip
element within the clip, can be published, i.e. made available to selected
groups of users.
See section "Publishing a Clip" on page 44.

Delete Allows the deletion of the selected clip, even if present in a playlist or
timeline. See section "Deleting a Clip" on page 33.
When deleting a clip from an XT node, the corresponding file will not be
deleted.
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Command Description

Delete
Selected
Clip
Elements

This option is only visible by hi-lo browsers. It is only available when right-
clicking a clip line, not a clip element line in clip expanded view.
The DeleteWindow is then displayed and allows you to select which ones
of the clip elements will be deleted.

See section "Deleting a Clip" on page 33 for information on the option
"delete clip if present in a playlist or timeline".

View Key
Clip

Displays the Key clip associated with a Fill clip that is selected. This
option is only active for Fill clips that are included in a Fill and Key
association.

Edit Opens the Edit Clip window from which the user canmodify the clip
information. Metadata is common between all clip elements.
See section "Edit ClipWindow" on page 34.

Modify
T/C IN or
Date

Opens theModify T/C In or Date window from which the user canmodify
the IN timecode or date of the clip.
See section "How toModify the T/C in or the Date of a Clip" on page 44.

Generate
XML
Metadata

The XML file is synchronized for the selected clip or clip element, provided
that the IP workstation has been configured as master. With workstations
configured as slave, an error message is displayed when using this option.

32 4. ClipsView

EVSBroadcast Equipment S.A. - November 2012 Issue 6.00.B



Command Description

Protect Allows you to protect or unprotect a clip from deletion:
• A Protect icon appears in theProtect column of the Elements grid

when the clip is protected.
• A message will warn you in IPDirector or in Multicam not to delete the

clip when the clip is protected.
• Only XT clips can be protected.

Unprotect Allows you to unprotect the selected clip when it has been protected in
IPDirector.

Duplicate Opens a Duplicate Clip window where you can specify the location on an
EVS video server of the XNet Network where a copy of the clip should be
stored.
Files are not duplicated, even if the command is applied at the clip level.
See section "How to Duplicate or Move a Clip by Specifying an Exact
Location" on page 36.

Move Opens aMove Clip window where you can specify the location on an EVS
video server of the XNet Network where the clip should bemoved.
This command is not available for files.
See section "How to Duplicate or Move a Clip by Specifying an Exact
Location" on page 36.

Link Allows you to link selected clips manually. It is only possible to link clips
that are not already associated with other clips.

Unlink Allows you to unlink the clips linked to the selected clips.

Properties Displays information related to the owner and the groups the selected clip
has been published to.

4.3. Deleting a Clip

When selecting theDelete option from the Clip contextual menu, the Delete Clips window
is displayed:
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You can choose whether you want to force the deletion of the clip even if it is present in a
playlist or timeline.

If you do not tick the box in the Delete Clips window, only clips not present in playlist or
timeline could be deleted.

If you tick the box, several cases can occur depending on whether the playlist or timeline
is on-line or off-line.

• On-line Timeline

If the clip is present in on-line timeline, the clip will be deleted and the timeline element
will be replaced by a black element.

• On-line Playlist

If the clip is present in an on-line playlist, both the clip and the playlist element will be
deleted.

This may be particularly useful when operators want to purge the servers after the
playlists have been played out.

In case a file is present on the nearline, you will be asked whether you want to keep it
or delete it.

• Off-line Playlist

In case you want to be able to reuse the playlist but you do not want to keep the clip,
you need to put the playlist off-line and then force the deletion of the clip from the
Database Explorer. The clip will then be replaced by a virtual element.

◦ If a corresponding file is still present on the nearline, it will be used when browsing
the playlist from the Software Player. In addition, the VarID will be used to restore
the XT clip in the playlist when you put the playlist on-line again.

◦ If no corresponding clip element is available after the deletion of the XT clip, this
latter will be replaced by a virtual element in the playlist.

4.4. Editing a Clip

4.4.1. How to Edit a Clip From Within the Database
Explorer
To edit the clip data, proceed as follows:

1. Select the clip or a clip element.

2. Right-click and select Edit.

The Edit Clip window appears offering the ability to add or change clip data. For more
information on the Edit Clip window, See section "Edit ClipWindow" on page 34.

4.4.2. Edit Clip Window
In the Edit Clip window you can add or change clip data. It is accessible from the clip
contextual menu in the Database Explorer.
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Changes are applied to all elements in the same clip, since all elements share the same
metadata.

The window is similar to the Save Clip window. See the Control Panel user manual for a
description of the fields and buttons displayed in the window.

4.5. Copying or Moving a Clip

4.5.1. Ways to Proceed
Different ways exist to move or copy a clip:

• by drag-and-drop operations

• by theDuplicate orMove options from the contextual menu

• by the GigE connection (for copy only)

Note 1
During a Duplicate operation, only the XT clip will be copied, not the file.
During aMove operation, only the XT clip will bemoved and receive a new LSM
ID. The file will keep the original LSM ID. However, the file will be listed under
the XT / page / bank of themoved clip, no longer under its previous location.
For example, a clip containing an XT clip and a file with "LSM ID = 621A/01" is
moved to position "113A/01". The clip is nomore displayed in page 6 of server
01. It is listed under server 01, page 1, bank 1 with "LSM ID = 113A" and
contains an XT clip with "LSM ID = 113A" and a file with LSM ID = "621A".

Note 2
As some copy or move operations may take place between EVS video servers
on the XNet they will take some time to complete.

4.5.2. Copying or Moving a Clip Using Drag-and-
Drop Operations
A clip can be selected in the right pane of the Database Explorer and dragged to a new
location in the tree structure in the left pane. The target is highlighted in the tree.

Depending on the option selected in Tools > Settings > General, the copy andmove
functions could be performed in different ways: Windows style, Google style or Dialog
Box style. Refer to section "Settings" in part 1 of the user manual for more information on
these options.

The Dialog Box Style is the default value. When dragging a clip, displays a popup window
and asks the operator for the operation to perform.
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Using this technique the clip will be copied or moved to the first available location in the
section of the tree it was dropped upon:

• If the clip is dropped on a server level of the tree it will be placed in the first available
space in the XT clip structure.

• If the clip is dropped on a page level of the tree it will be placed in the first available
space in the page structure.

• If the clip is dropped on a bank level of the tree it will be placed in the first available
space in the bank structure.

4.5.3. How to Duplicate or Move a Clip by Specifying
an Exact Location
To duplicate or move a clip to an exact location, proceed as follows:

1. Select a clip to bemoved or copied. You can select either themain clip line or the XT
clip line in the Database Explorer.

2. Right-click the clip and selectMove orDuplicate.

3. TheMove window or Duplicate window is displayed asking for the LSM ID for the new
location.

4. Type the LSM ID in the Target Clip ID field.

5. Click theMove button in theMove window, or theOK button in the Duplicate window.

The clip will bemoved or duplicated (copied) to the location specified in the Target Clip
ID field.

4.5.4. How to Copy a Clip to an EVS Video Server
through the Gigabit Ethernet
It is possible to copy a clip to an EVS video server belonging to the same or another XNet
network through theGigE network via the Gigabit Ethernet connection. For more
information, refer to the Technical Referencemanual.

To copy a clip to an EVS video server, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to copy to
another server.

The clip contextual menu is displayed.
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2. Select Copy by GigE from themenu and the server you want to copy the clip to from
the Send to sub-menu.

The clip is copied and the icon appears in theStatus column.

Note
When copying a clip to another EVS video server from the same network, this
option can be used rather than the Send to > XT option to avoid the creation of a
target.

4.6. Sending a Clip to a Destination Target

4.6.1. Introduction
IPDirector gives full flexibility to directly send A/V files to third party systems (i.e. NLE
systems) and storage paths. Sendingmedia to third party systems will be performed with
theSend to command. Sendingmedia to removable drives will be performed with the
Backup to Nearline command.
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4.6.2. Send To Menu

Note
Icons for destinations targets may have been customized from the Remote
Installer.

4.6.3. How to Send a Clip to the Default Archive
To flag a clip to be sent to the default archive, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to send to the
default archive.

The clip contextual menu is displayed.

2. Select Send To > Default Archive from the clip contextual menu.

The clip is flagged to be sent to the session folder of the XFile defined as the default XFile
on the EVS video server where the XT clip is physically stored.

Refer to the XFile user manual for more information on how to define the session folder.

4.6.4. How to Send a Clip to a Destination Folder
(Destination Target)
IPDirector gives full flexibility to directly send A/V files to third party systems (i.e. NLE
systems). Clips can be sent to a destination target through the XNet network or the GigE
network. The network used for the transfer depends on the setup defined. For more
information, refer to the Technical Referencemanual.
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To send a clip to a destination target, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to send to a
destination target.

The clip contextual menu is displayed.

2. Select Send To from the clip contextual menu and select a destination target.

The clip is sent to the destination target and the icon corresponding to the selected
destination target and to the transfer status is displayed in theStatus column of the
Database Explorer. See section "Status Icons" on page 29.

Note
Icons for destinations targets may have been customized from the Remote
Installer.

4.6.5. How to Add a Destination Target
To add a destination target to the list, proceed as follows:

1. Right-click the clip list in the Database Explorer grid.

The Clip contextual menu is displayed.

2. Select theAdd File Archive Target option from the Send To submenu.

The New Archive Target window opens.

3. Fill in the field in the New Archive Target window.

See section "New Archive Target Window" on page 39 for more information on the
fields.

4. Select OK.

The new destination target is added to the list of destination targets in the contextual
menu.

4.6.6. New Archive Target Window
The New Archive Target window makes it possible to add a new destination or archive
target. The fields displayed on the New Archive Target Window are described below:
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Field Description

Target
Name

The name of the target as it will appear in the contextual menu.

Backup
Destination
Directory

The destination folder where the file will be copied. Be sure this directory
is shared with full control access.

File Format The file format. It can beMXF EVS, MXF OP1A, QuickTimeMovie, or
QuickTimeReference, MXF OPAtom, AVI.

XML Unit Drop-down list with the available XMLUnits, as defined in the Remote
Installer, which couldmanage all the files sent to the destination target.

Generate
XML
Metadata
file

When this check-box is selected, an XML file with themetadata of the
clips backed up is generated. This file is created at the same time as the
backup file for all media file formats. In theMXF EVS format, the
metadata is included in themedia file itself.

XML
Metadata
file path

The destination folder where the XMLMetadata file will be stored.

4.6.7. How to Delete a Destination Target
To delete a destination target from the list, proceed as follows:

1. Right-click the Clip list in the Database Explorer grid.

The Clip contextual menu is displayed.
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2. Select Remove Archive Target from the Send To sub-menu.

The Remove Archive Target window is displayed.

3. Select a target from the list.

4. Click theRemove button.

5. AnswerYes to the question asked to confirm the operation.

The archive target does not appear in the Send to contextual menu any more.

4.6.8. How to Send a Clip to a Xedio CleanEdit
Storage
To send a clip to a Xedio CleanEdit storage, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to send to
CleanEdit.

The clip contextual menu is displayed.

2. Select Send To from the clip contextual menu and select a predefined CleanEdit
target from theSend To > CleanEdit submenu.

Once the clip has been sent, it is immediately available in the CleanEdit database. It can
then be inserted into a project, edited or played out using Playout Organizer or
CleanPlayout Server.

Note
Which clip elements will be sent depends on the target: you can configure hi-res
targets, lo-res targets or hi/lo targets.
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Required Configuration

These destination targets are defined from the IPDirector Remote Installer and a
corresponding XFile XML unit must have been correctly configured. The name used to
define the type of transfer is user-definable andmay be different from the CleanEdit target
used in the screenshot above. Refer to the IPDirector Remote Installer and XFile user
manual for more information.

4.6.9. How to Send a Clip to an Avid System Using
the AVID Transfer Manager
To send a clip to an Avid system using the Transfer Manager, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to send to
Avid.

The clip contextual menu is displayed.

2. Select Send To from the clip contextual menu and select a predefined Avid TM target
from theSend To > Avid submenu.

Once the clip has been sent, it is immediately available in an Avid (When an Asset
management system is in use, like Interplay or mediaManager). It can then be inserted
into a bin and can be inserted into an edit.

Note
With Avid and FCP targets, the hi-res element is sent, with a priority on the XT
clip.

Required Configuration for Transfer

Clips can be sent via two different paths to an Avid system:

• The first method is to send them through the XNet network and then through theGigE
network between the Avid device and XFile. This methodmust be used if the EVS
video servers are not GigE equipped.

• The second and newermethod would send themedia directly from the EVS video
servers Gigabit Ethernet ports to the AVID TM initiated by an instruction to an
installed XTAccess application.

The network used for the transfer depends on the setup. For more information, refer to the
Technical Referencemanual.

The Avid destination targets are predefined from the IPDirector Remote Installer. The
name used to define the type of transfer is user-definable andmay be different from the
Avid target used in the screenshot above. Refer to the IPDirector Remote Installer manual
for more information.

Avid TM, XFile and XTAccess components must have been correctly configured in order
to automate this procedure. Please refer to the corresponding user's manual for more
information.
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4.6.10. Transfer Monitoring
Transfers can bemonitored from within the Database Explorer.

Click Tools > Transfer Monitoring in the Database Explorer toolbar:

This will show themonitoring pane inside Database Explorer:

In this pane, you can only see transfer information about the selected item in the Elements
grid above.

Note
More extensive transfer monitoring options are available from themain
IPDirector window.
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4.7. How to Modify the T/C in or the Date of a
Clip

The T/C and date corresponding to the IN point of a clip can bemodified from the
contextual menu. This operation is very useful when re-ingesting a feed whichmust then
be associated to a logsheet, or simply because the A/V material ingested corresponds to
A/V material which was originally recorded at a different T/C and date.

Tomodify the T/C IN or Date of a clip, proceed as follows:

1. Right-click the clip line (or XT clip line) in the Database Explorer grid.

The clip contextual menu is displayed.

2. SelectModify T/C IN or Date.

This opens the following window:

3. Type the new Timecode IN with the format HH:MM:SS:FF in the IN field.

4. Select the new Date for the clip in theDate In drop-down list.

5. Click theSave button to save your changes.

Note
This option is available whenmultiple clips are selected. All the controls have
then empty values and a single change can be applied to the entire selection at
once.

4.8. Publishing a Clip

4.8.1. Introduction
Publishing a clip makes it visible to members of the group(s) the clip is published to.

Depending on the place you right-click, different clip elements from the clip will be
published:
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Right-click on… Result

Clip line All the clip elements are published.
TheGroup Name the clip has been published to appears in the
Published column, next to the clip and all the clip elements

XT hi-res clip Only the XT clip is published, not the file.
TheGroup Name appears in thePublished column, next to the clip
and the XT clip element.

File Only the file is published, not the XT clip.
TheGroup Name appears in thePublished column, next to the file.

4.8.2. How to Publish a Clip
To publish a clip to groups of users from the Database Explorer, proceed as follows:

1. Right-click the clip to be published.

The Clip contextual menu is displayed.

2. Select Publish from the contextual menu.

The Publish Clip window opens.

3. Select the user group(s) to which you want to publish the clip in the Available Groups
area. KeepCTRL pressed to select multiple groups.

4. Click theAdd button tomove the selected user groups from the Available Groups to
the Selected Groups.

5. Click thePublish button.

All users belonging to the selected user groups and having visibility rights on the clip will
be able to view it.
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4.9. How to Assign Keywords to One or
Several Clips

To assign keywords to one or several clips, proceed as follows:

1. Select a clip or clip element in Clip, Clip element or bins/clips branches of the
Database Explorer grid.

2. Click theAssign button. It becomes colored to indicate that the Assignmode is
active.

3. Open a keyword grid or a keyword dictionary.

TheApply buttonmust be active
4. Select the keywords you want to assign to themedia.

5. Click theApply button.

Keywords are assigned to the clip or clip element and appeared inKeywords columns
of the Database Explorer grid.
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5. Clip Elements View

5.1. Introduction

A clip element is the physical resource inside the clip: XT clip or media file. Every element
in a clip shares the same T/C IN and T/C OUT. See section "Clip Element Types" on
page 17 for the different kinds of clip elements.

When visible, clicking the Clip Elements branch of the tree displays a flat view of the clip
elements list in the Elements grid. Each element is displayed on a separate line within the
grid.

It also lists the record trains from the servers present on the XNet.

5.2. Limitations

• The Clip Elements branch can be viewed only by administrators/media managers or,
in hi-lo mode, by hi-lo browsers with appropriate user rights. They first need to select
theShow Clip Elements Plug-in option from the View contextual menu.

• It is not possible to define a bin rule from the Clip Element node.
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5.3. Clip Elements Tree Structure

Like the Clips branch, the Clip Elements tree structure of IPDirector, makes the following
sub-branches available:

• Physical hardware present on the XNet, such as:

◦ hi-res EVS video servers: displays XT hi-res-clips saved on the hi-res EVS video
servers.

Light clips are listed here as well even if they are not saved on a server but only
refer to a normal clip itself saved on a server.
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◦ lo-res EVS video servers: displays XT lo-res-clips saved on the lo-res EVS video
servers

◦ XF[2] or XStore hosting XFile software: displays clips which have been backed up
to XFile and then published from XFile to the XNet

Even if an XT clip is backed up to XFile in a file format, when the file is published
from XFile, it appears as "XT type" element in the Elements grid.

Eachmachine can be searched by browsing the tree from network number > page >
bank.

• On-line nearline: displays hi-res and lo-res files which have been backed up to
nearline/IP drive and for which the IP drive is still present on the XNet, so they still can
be immediately retrievable.

• Off-line nearline: displays hi-res and lo-res files which have been backed up to
nearline/IP drive and for which the IP drive has been removed. So, IP drive
identification allows files to be retrieved after re-inserting the drive.

5.4. Clip Elements Data Columns

The clip element information is organized in columns. Some of the details can be edited
from here, others are for viewing only. All the headers can be used as filters when
performing a search.

Most of the columns are the same than for Clips. See section "Clip Data Columns" on
page 26. Differences are listed in the table below.

Column Name Description

Element Indicates
• File: for hi-res and lo-res files
• XT: for hi-res and lo-res clips
• XT: for XFile backup files which have been published on the XNet.

LSM ID This is the real LDM ID as explained in section "Virtual LSM ID / Real
LSM ID" on page 19.

Material ID A unique identifier given to an original clip by EVS not generally in use
at an operational level. This ID stays with the clip and will keep track
of copies of a clip related to the original by using this ID as it will not
change on the clip copies.

Hi-Lo Indicates whether the clip element is hi-res or lo-res.
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Column Name Description

Storage Name of the storage on which the clip element is stored:
• EVS video server for XT clips
• for nearline defined in the configurationmenu: nearline directory for

files
• for detected IP drives: "drive name" on "machine name".
Storage of off-line clip elements are included if Show offline files is
enabled.

Master This information is only for files. The column is empty for clips.
Themaster file is the first file created for a clip element and detected
on the nearline. TheMaster column indicates YES.
When shorter clips, are created from a file, they receive the flagNO in
theMaster column.

Full Path Only for files.

File Name Only for files.

Cam Pref. Displays a preference value that is generated when clips are created
from an LSM control panel.

Nb Audio
Tracks

How many audio tracks the clip has.

Video Format Shows the video format of the clip:
PAL SD 625i, PAL HD 1080i, NTSC HD 1080i, …

Video Codec Shows the video codec of the clip:
DNxHD, MPEG2 i-frame, …

Video Bitrate Shows the video bitrate of the clip: from 20 to 360.

Aspect Ratio 4:3 Letter Box, 4:3 Box, or 16:9.

VBI This has a value when the clip contains information within the picture
such as teletext, VITC or other such data needed by graphics
applications.

Audio Type Mono, Stereo, Dual Stereo, 8 tracks.

5.5. Clip Element Contextual Menu

The Clip Element contextual menu is displayed when right-clicking a clip element line. It is
the same as the Clip contextual menu obtained from the Clips Elements grid.

See section "Clip Contextual Menu" on page 30 for a detailed description of the different
options available.
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5.6. Deleting Clip Elements

When the user is viewing elements in this view, the only option is to delete directly the
element. There are no options for individual deletion of related elements. See section
"Deleting a Clip" on page 33.

In case of protected clip, the following warning is displayed in theMessage Panel:

If the user is deleting a file, the user must have permissions to delete the file.

If the file is part of a clip, the user will receive a dialog box to delete the file or not.

5.7. How to Manually Associate a Clip
Element to an Existing Clip

Tomanually associate a clip element and an existing clip with matching TC, proceed as
follows:

1. In the Elements grid, select a clip from the Clips view.

2. In the Database Explorer Tools menu, select Clip Element Association.

The Clip Element Association window opens.

3. Drag the clip line on theName field of the Clip Element Association window.

Fields are automatically filled with clip information.

4. In the Elements grid, select a clip element.

5. Drag the clip element line on the right pane of the Clip Element Association window.

The association is created.

Note
Both LTC and USER TC must match for the association to be accepted.
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6. Playlists View

6.1. Introduction

A playlist is a group of clips put together to play out in a desired order.

Depending on the required complexity, different video and audio transitions can be defined
between each element of the playlist. Two types of playlist exist: off-line and on-line
playlists. An offline playlist is a playlist that does not yet reside on an EVS video server
but only exists inside the IPDirector database. For more information, refer to the section
on off-line and on-line playlists in the Playlist Panel chapter, in Part 6 of this user manual.

6.2. Playlists Tree Structure

Playlists are stored in bank 0 of each page within an EVS video server. There are 10
spaces per page giving room to 100 playlists per EVS server. The on-line playlists tree
structure of the Database Explorer shows each EVS server and a sub tree for each page.

Right-clicking the playlists tree view gives access to the following contextual menu:

See section "Playlist Contextual Menu" on page 53 for a description of these options.

6.3. Playlists Data Columns

Each playlist record in the list is shownwith variable width columns providing information
about the data stored with the playlist.

Note
See section "Organizing Columns" on page 13 for details on how to hide or show
columns.
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Here are some of the columns which can be selected:

Column Name Description

Name A playlist can be named:
• using the EVS video server keyboard
• from the Database Explorer

LSM ID PLNumber and EVS video server number that the playlist is on

Duration Length of the playlist

Nbr of Elements Number of elements in the playlist

AuxClip ID Louth of an auxiliary track associated with a playlist

Owner User who created the playlist

Published Groups to which the playlist is published

Creation Date Date when the playlist has been created

Ganged Displays a ganged group that this PL is linked to

Keywords Displays keywords that are associated to the playlist

Type Displays if this is a normal playlist or defined as Fill or Key

Hi-Lo Displays if this playlist is a hi-res or lo-res PL

6.4. Playlist Contextual Menu

The Playlist contextual menu is available when right-clicking a playlist in the Elements
grid. It gives access to actions that can be performed on playlists in the Database
Explorer:

Command Description

Cut Not relevant in the Elements grid.

Copy Copies the playlist to the clipboard. A shortcut can be pasted in a bin.

Paste Not relevant in the Elements grid.

New Playlist Opens the Create New Playlist window to create a new playlist.

Copy clips
locally

Only available if the playlist is on-line on an EVS server.
Copies the distant clips of the selected playlist to the local EVS video
server, i.e. the server on which the playlist is stored.
Two options are available from the sub-menu:
• Copy long (copy of the original clip, with its guardbands)
• Copy short (copy of the playlist element, with guardbands as

defined in the settings)
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Command Description

Convert to
Timeline

Opens theMake a Timeline Online window and permits to convert the
selected playlist into a timeline which could then bemanaged through
IPEdit.
See the Playlist Panel user manual.

Convert to
Edit

Converts the playlist to an edit which could bemanaged by Xedio
CleanEdit. See the Playlist Panel user manual.

Send to Provides a submenu with the list of possible destinations to which the
user can send the selected playlist
Examples of possible destinations are:
• the user's default bin
• a default archive target
• any target destination visible on the GigE network that has been

defined in the Remote Installer (CleanEdit targets, Avid targets,
Final Cut Pro targets, File targets, EVS servers targets). This is
used tomake A/V material available to external systems.

Flatten to XT Displays a list of hi-res EVS servers and pages available on the XNet
network to which the user can store a consolidated clip out of the
selected playlist.
The flattened clip will have the same VarID as the original playlist. That
is the reason why the flattened clip cannot be stored on the same EVS
server as the original playlist, otherwise, this would result in a VarID
conflict.

Backup to
Nearline

Provides a submenu with the list of nearline folders to which the user
can back up the open playlist to a file.
The transfer types and file formats are defined in the Nearline definition
in the Remote Installer.

Import Allows importing the playlist structure and playlist related information
from an XML file into IPDirector.
See section "Playlist Imports" on page 56.

Export Allows exporting the loaded playlist structure and playlist related
information from IPDirector to an XML file or CSV file.

Publish Opens the Publish Playlist window in which the operators can specify
the user groups the loaded playlist should be published to.
The playlist will be published to the selected groups on the condition
that they have the adequate visibility rights.

Edit/Rename Opens the Edit a Playlist window in which you canmodify the playlist
properties as entered when the playlist was created.

Regenerate
T/C Output

Allows generating a continuous timecode to be able to browse a playlist
easily.

Delete
playlist

Deletes the selected playlist. The option is only available when the
playlist is not loaded on a player channel.
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Command Description

Delete
playlist and
clips

Deletes the selected playlist and all the clips contained in the playlist,
provided that they are not inserted into another playlist. The option is
only available when the playlist is not loaded on a player channel.
The following window opens and allows you to select the clip element
types you want to delete.

Delete all
unused
playlists

Opens the Delete Unused Playlists window from which you can select
a reference date for the deletion of playlists.
All the playlists (on all the EVS video servers of the XNet network) not
used since the reference date will be displayed in the window. All the
retrieved playlists or a selection of them can be deleted.

Set as
default
playlist

Sets the selected playlist as default playlist.

Create an
off-line copy

Creates an off-line copy of the selected playlist. This new off-line
playlist has the same content as the playlist selected. It also has the
same name. It has no LSM ID.

Copy/Move
Playlist

This allows the users to:
• create an off-line or on-line copy of the open playlist
• move the playlist to another EVS server
• make the playlist off-line.

Link Allows you to link the selected playlists together.

Unlink Allows you to unlink the playlists linked to the selected playlists.

Search for
clips not in
the selected
playlists

Opens a second Database Explorer window displaying the list of clips
not present in the selected playlist. See section "Clips not in a Selected
Playlist" on page 104.

Properties Displays information related to the owner and the groups the selected
playlist has been published to.

For more information on these actions, refer to the Playlist Panel chapter, in part 6 of this
user manual.
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6.5. Copying or Moving a Playlist

Different ways exist to move or copy a playlist:

• by drag-and-drop operations: this can be done as explained for clips in See section
"Copying or Moving a Clip Using Drag-and-DropOperations" on page 35.

• by theCopy/Move option from the contextual menu: this can be done as explained in
section "Copying andMoving a Playlist" in part 6 of the user manual.

6.6. How to Delete A Playlist

To delete a playlist, proceed as follows:

1. Right-click the playlist to delete.

The Playlist contextual menu opens.

2. Select Delete Playlist.

3. Confirm the deletion in the Delete Playlist(s) window that appears.

The playlist is deleted from the EVS video server and from the Database.

6.7. Playlist Imports

6.7.1. Import Options
Importing a playlist can be performed from several locations in the Database Explorer.
This option is always available from

• the Playlist contextual menu of the Playlist tree view (Import…)

• the Bin contextual menu of the Bin tree view (Import a Playlist…)

• the Playlists list displayed in the grid (Import…)

6.7.2. How to Import a Playlist
To import the playlist definition, proceed as follows:

1. Right-click one of the locations listed above.

A contextual menu is displayed.

2. According to themenu, select Import or Import a Playlist from the contextual menu.

The Import Playlists window opens.

3. In this window, select the file that contains the playlist to import.

4. Click Open.
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5. TheMake a Playlist On-line window opens:

Note
This window is not displayed when the import is done from the Playlist node
or from the Playlist>Off-line node of the tree view.
In these cases, the playlist is made off-line.

6. Select an EVS video server to make the playlist on-line orNone to make it off-line.

7. Select the Import and restore available files box if you want to restore the clips
making the playlist as well.

Note
Files must be on the nearline to be available.

8. Click OK.

The playlist and the clips are imported.
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7. Timelines View

7.1. Introduction

A timeline is a series of clips put together in a given sequence. Audio and video effects
can be added between the clips of a timeline to create transitions, andmany other editing
actions are possible on a timeline. In a timeline, the video and audio tracks of a clip can be
desynchronized from each other, unlike in a playlist.

In this branch of the tree, you can see timelines but not create or edit them. Timelines are
created, managed and edited in the IPEdit Module which is documented separately.

Unlike the playlist branches of the tree, there is no contextual menu for the Timelines
branch in the Database Explorer tree.

7.2. Timelines Data Columns

Each timeline record in the list is shownwith columns providing information about the data
stored with the timeline.

Note
See section "Organizing Columns" on page 13 for details on how to hide or show
columns.

Here are some of the columns which can be selected:

Column Name Description

Name Timeline name

Description Free text description entered in the Create a Timeline window.

LSM ID Timeline number and EVS video server number where the timeline
is stored.

Nbr of Tracks Number of timeline tracks (video + audio)

Audio
Configuration

Number of audio tracks and number of audio channels in the
tracks.

Duration Length of the timeline (hh:mm:ss:ff)

Keywords A list of the standard keywords that have been associated with the
timeline.

Participants A list of the participant keywords that have been associated with
the timeline.
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7.3. Timeline Contextual menu

If you right-click an item in the Timeline Elements grid, the following contextual menu
appears:

Command Description

Cut Not implemented

Copy Not implemented

Paste Not implemented

Copy/Move
Timeline

Opens a window from which you can create a copy of the timeline on a
selected EVS video server.

Copy Clips
locally >
Copy short

Creates a local copy of the timeline clips that are not stored on the
same EVS video server as the timeline. This copy will only include the
media needed inside the edit with minimal guardbands created during
copy.

Copy Clips
locally >
Copy long

Creates a local copy of the timeline clips that are not stored on the
same EVS video server as the timeline. This copy will include the
complete original clips in their entirety.

Publish Opens the Publish window in which you can specify the user groups the
selected timeline should be published to.
The timeline will be published to the selected groups providing that they
have the adequate rights.

Edit/Rename Opens the Edit a Timeline window in which you canmodify the timeline
properties as entered when the timeline was created. The audio
configuration can however not bemodified.

Delete Deletes the timeline from the EVS video server. This does not delete
the related clips.

Delete
Timeline
and Clips

Deletes the timeline, as well as the clips created by the timeline engine,
from the EVS video server.

Send to Provides a list of possible destinations to which the selected timeline
can be sent.
Possible destinations are:
• the user's default bin
• the user's default playlist
• a default archive target
• any target destination visible on the GigE network that has been

defined in the Remote Installer (CleanEdit targets, Avid targets,
Final Cut Pro targets, File targets, XT targets). This is used tomake
A/V material available to external systems.
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Command Description

Flatten to XT Displays a list of hi-res EVS servers and pages available on the XNet
network to which the user can store a consolidated clip out of the open
timeline.
The flattened clip will have the same VarID as the original timeline.

Backup to
nearline

Provides a list of possible destinations to which the selected timeline
can be sent, that is to say any destination folder visible on the GigE
network that has been defined in the Remote Installer to allow timeline
transfer.
This is used to store or back up A/V material.
Users can access the A/V material of nearline folders in IPDirector, or
restore it on an EVS server.

Export
timeline

Allows exporting the definition (EDL) of the loaded timeline, in other
words the timeline structure and timeline related information, in .xml
format. This does not export the timelinematerial.
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8. Edits View

8.1. Introduction

An edit is a container for an EDL, or Edit Decision List. It is represented by its name, its
metadata and its EDL. The EDL is the representation of the edit. Edits may have been
created from the Xedio IPD Plugin, the Director's Cut module of IPDirector or the
IPBrowse application but edits can only bemodified from the CleanEdit interface.

Right-clicking the Edits tree branch or an edit in the Elements grid gives access to a
contextual menu.

See section "Edit Contextual Menu" on page 61 for a description of these options.

8.2. Edit Contextual Menu

The Edit contextual menu is available when right-clicking an edit in the Elements grid. It
gives access to actions that can be performed on edits from the Database Explorer.

Command Description

Cut Cuts the selected edit. Only available from the Edits tab when a Bins
tree branch is selected.

Copy Copies the selected edit. A shortcut can then be pasted in a bin.

Paste Pastes the copied or cut edit. Only available from the Edits tab when a
Bins tree branch is selected.

New Edit Opens the New Edit window to create a new edit. See section "Creating
an Edit" on page 62.

Send to Provides a submenu with the list of possible destinations to which the
user can send the selected edit(s). Examples of possible destinations
are:
• the user's default bin
• a default archive target
• any target destination visible on the GigE network that has been

defined in the Remote Installer (CleanEdit targets, Avid targets,
Final Cut Pro targets, File targets, EVS servers targets). This is
used tomake A/V material available to external systems.

Flatten to XT Displays a list of hi-res EVS servers and pages available on the XNet
network to which the user can store the selected edit(s).

Backup to
Nearline

Provides a submenu with the list of nearline folders to which the user
can back up the edit. The transfer types and file formats are defined in
the Nearline definition in the Remote Installer.
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Command Description

Import... Allows importing an edit, together with its EDL andmetadata from an
XML file into IPDirector.

Export... Allows exporting the selected edit. The whole EDL is copied to an XML
file.

Publish Opens the Publish window in which the operators can specify the user
groups the selected edit(s) should be published to. The edit will be
published to the selected groups on the condition that they have the
adequate visibility rights.

Edit/Rename Opens the Edit Edit window in which you canmodify the edit information
andmetadata as entered when the edit was created.

Delete edit Deletes the selected edit(s).

Duplicate Duplicates the edit by creating a new one with the same name,
metadata and EDL.

Convert to
XT Timeline

Opens theMake a Timeline Online window and permits to convert the
selected edit into a timeline which could then bemanaged through
IPEdit.

Properties Displays information related to the owner and the groups the selected
edit has been published to.

8.3. Creating an Edit

Possible Ways for Creating an Edit

From the Database Explorer, users can create an edit in one of the following ways:

• Create an empty edit with an EDL containing the edit metadata. This is done by right-
clicking theEdit tree branch or an edit in the Elements grid, selectingNew Edit from
the contextual menu and filling the New Edit window described hereafter.

• Convert a playlist into an edit, as described in the Playlist Panel user manual. This is
done by right-clicking a playlist in the Elements grid and selectingConvert to Edit.

New Edit Window

Window Overview

While creating a new edit, the New Edit window will open. This window makes it possible
to enter general and customer-defined data (called "metadata") for the edit.

Note
When theEdit/Rename option has been selected from the Edit contextual
menu, the Edit window opens. It is similar to the New Edit window and it shows
the data already entered for the edit. Users will not be able tomodify some of
them.
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The New Edit window is divided into two panes:

• The left pane contains the edit information, i.e. edit general data.

It is always displayed.

• The right pane contains the edit metadata, i.e. edit data based on customer-specific
fields defined in themetadata profile.

It is displayed by clicking the right area in the Pane Display button .

Elements in the New Edit Window

The Edit Information pane contains the following user interface elements.

User Interface
Element

Description

Tape ID This identifies the tape on which the edit is stored.

Name User-defined name for the edit. It can contain up to 64 alphanumeric
characters.

VarID VarID is a 32-character ID with variable length and format. It is
automatically assigned to new edit. It is mainly used to ensure
redundancy on the system. It can be unique for an edit on the EVS
server level or on the XNet network level, depending on EVS video
server settings.

TC Track Start Timecode value of the first field of the edit.
The default value can be set under Tools > Settings > IPEdit >
General > Control Track Initial Timecode, or left empty so the
edit timecode will start at 00:00:00:00.

Description Free text describing the edit.
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User Interface
Element

Description

Keywords The Keyword area allows you to assign up to five keywords to an
edit to qualify its content.
To add a keyword, select it from the Keyword Grid or Keyword
Dictionary or type its first letters and select it from the Autocomplete
list. Refer to the KeywordManagement chapter for more information
on how tomaintain keywords and assign them tomedia.

Interest Level User-defined rating of the edit.
Possible values are: no star, one star, two stars, and three stars.

Owner Name of the user who creates the edit.

Aspect Ratio Aspect ratio of the edit. The possible values are [empty], 4:3, 16:9.
The 16:9 value is automatically selected and cannot be changed
when an HD video standard is choosen.
When the Edit Edit window is opened, an aspect ratio value can only
be entered if the field was previously left empty.

Audio Type Audio type of the edit. It defines themapping of the audio tracks in
the EDL. The possible values areAll stereo, 5.1 + 5 stereo, 2x5.1
+ 2x stereo.
When the Edit Edit window is opened, an audio type value can only
be entered if the field was previously left empty.

Video Standard Video standard of the edit.
When the Edit Edit window is opened, a video standard value can
only be entered if the field was previously left empty.

Conversion
Type

Conversion type for the aspect ratio of the edit.
If the aspect ratio is set to 16:9, the possible values are 4:3 -> 16:9
(PS), 4:3 -> 16:9 (LB).
If the aspect ratio is set to 4:3, the possible values are 16:9 -> 4:3
(PS), 16:9 -> 4:3 (LB)

The Edit Metadata pane contains the following fields:

Field Description

Current Profile Drop-down list in which the users can select aMetadata profile other
than the current one, if they have appropriate user rights. The
selected profile will be applied to the new edit.
By default, the default profile specified in theMetadata Profile
Management Window is automatically applied with its fields and
default values to each new edit.
Refer to section "MetadataManagement" in the user manual for
more information onMetadata Profile management.

Metadata
Profile fields

The user canmodify the values of the edit profile fields. The
modifications will only apply to the edit and not impact the default
values of the profile.
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9. Bins View

9.1. Introduction

All media connected to a particular project or event can be organized into a bin, regardless
of clip numbers or storage locations. This makes it possible to treat the entire XNet
network and nearline storage as one storage location, searchable by a standard database.

The results of searches can be stored to a bin to allow more immediate access tomedia
whichmay be stored on any machine on the XNet network.

Bins can now also include a Post-Process so-as to perform a function to all items arriving
into a bin.

9.2. Bins Tree Structure

9.2.1. Introduction
The Bins tree structure does not use any of the existing clip structure of the EVS video
platform: it is customized by the users depending on how they want to organize their clips,
playlists, timelines or edits. In the bin tree structure, the following rules are applicable:

• A directory can contain other directories or bins.

• A bin cannot contain a directory or another bin.

9.2.2. Tree View Elements
The table below mentions which elements are displayed in the Elements grid based on the
selected tree branch and the selected item type (clips, playlists, timelines or edits).

Tree Branch
/ Sub-Branch

Description

Bins Shows all the elements which are in bins and bin directories.
Expanding the Bins view shows the bins and bin directories.

Bin Directory: shows all the elements which are in all the bins and
directories under the selected directory.

Bin: shows all the elements which are in the selected bin.

Bin set as default bin.
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Tree Branch
/ Sub-Branch

Description

Users Bin Directory: shows all the elements which are under all the
[User] bin directories.
Expanding the Users Bin view displays the [User] bin directories for all
the IPDirector users.

It is created by the system. It is visible by all the users but no one can
modify, delete or publish it, nor add a bin or bin directory directly under
this directory.

System [User] Bin Directory: shows all the elements which are in the
bins for the selected user.
Expanding a [User] bin directory view displays all the bins and bin
directories for the selected user (here: pge). Its name contains the user
logging ID.

It is visible by all the users but only the owner of the directory and an
administrator canmodify, delete or publish it, or add a bin or bin
directory directly under this directory.

System [User] Bin created by the system for the selected user. Its
name contains the user logging ID.
It shows all the elements put in it by the selected user.
It is visible by all the users but only the owner of the bin and an
administrator canmodify, delete or publish it, or move this bin.

[User] Bin created by the selected user.
It shows all the elements put in it by the selected user.

[User] Bin created by the selected user under its System [User] bin
directory and set as default bin. It shows all the elements put in it by
the selected user.

[User] Bin Directory created by the selected user under its System
[User] bin directory. It shows all the elements put in it by the selected
user.
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9.2.3. Bin Contextual Menu
Right-clicking the Bins branch in the Tree view opens a contextual menu that gives
access to the following commands:

Command Description

Open bin Opens the bin in a separate window.

Send to Provides a list of possible destination targets to which the
selected bin can be sent.

Backup to
nearline

Provides the list of nearline destinations to which the selected bin
can be sent.

Import a playlist Opens the Import Playlists window where you can select a
playlist to import into the bin.

Publish Opens the Publish bin window in which you can specify the user
groups the selected bin should be published to.
The bin will be published to the selected groups, providing that
they have the adequate rights.

New bin Opens the Create a New Bin window where you can specify the
name of the new bin.
This is available from a bin directory or from the Bin node of the
tree view. Not available inside a bin.

New directory Opens the Create a New Directory window where you can
specify the name of the new directory.
This is available from a bin directory or from the Bin node of the
tree view. Not available inside a bin.

Delete selected Deletes the selected bin or directory.
Click Yes in the confirmation window that appears to delete the
bin or directory.

Rename selected Opens theModify window where you can change the name and
description of the bin or directory.

Set as default bin Allows you to set the selected bin as default bin, for use in Send
to operations.

Go to default bin Opens the default bin in a new Database Explorer window.
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Command Description

Bin rules Opens a sub-menu with Bin rules operations.

Create a new
playlist (off-line)

Opens the Enter off-line playlist namewindow from which you
can create a new off-line playlist based on the selected bin.

Properties Displays information related to the owner and the groups the
selected bin or directory has been published to.

9.3. Elements Grid for Bins

9.3.1. Introduction
In the element view of a bin, you can select which item type you wish to view by clicking
the corresponding button.

9.3.2. Bin Data Columns
Each bin contains a list of clip elements, playlists, timelines or edits with all the data
available for each item and displayed in columns.

9.3.3. Bin Element Contextual menu
The contextual menus available when right-clicking a bin item in the Elements grid are
similar to those in the Elements grids for each type of items.

The commands that differ from the contextual menus in the other Elements grids are
detailed in the table below.

For information on the common commands, refer to the following sections:

• "Clip Contextual Menu" on page 30,

• "Playlist Contextual Menu" on page 53,

• "Timeline Contextual menu" on page 59

• "Edit Contextual Menu" on page 61 .

68 9. BinsView

EVSBroadcast Equipment S.A. - November 2012 Issue 6.00.B



Command Description

Remove from
bin only

Removes the selected item from the bin.

CLIPS: Delete Deletes the selected clip from the bin and the actual clip location.
This option is not available if the clip is part of a playlist or loaded
currently on channels of an EVS video server.

PLAYLISTS:
Delete Playlist

Deletes the selected playlist from the bin and the actual playlist
location.

TIMELINES:
Delete

Deletes the selected timeline from the bin and the actual timeline
location.

9.4. Opening a Bin in a Separate Bin Window

To open a bin window to drag clips into or see clips that are included in it, double-click the
bin name in the Tree view.
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9.5. Publishing a Bin or a Bin Directory

9.5.1. How to Publish a Bin
To publish a bin, proceed as follows:

1. In the Tree view, right-click the bin you want to publish.

The Bin contextual menu is displayed.

2. Select Publish from themenu.

The Publish window opens.

3. In the Available Groups pane, select the group(s) you want to publish the bin to and
move them to the Selected Groups pane on the right.

4. Click Publish.

The bin is published. The items (clips, playlists, timelines, edits) present in the bin are
published.

All the items (clips, playlists, timelines, edits) sent to the bin after the publication are
automatically published.

9.5.2. How to Un-Publish a Bin
To un-publish a bin, proceed as follows:

1. In the tree view, right-click the bin you want to un-publish.

The Bin contextual menu is displayed.

2. Select Publish from themenu.

The Publish window opens.

3. In the Selected Groups pane, select the group(s) you want to un-publish the bin to and
move them to Available Groups the pane on the left.

4. Click Publish.

The bin is un-published.

The items (clips, playlists, timelines, edits) present in the bin remain published.

9.5.3. Rules when Publishing a Bin Directory
When a bin directory is published, all the bins and the directories in the bin directory are
published. Any bin or bin directory created afterward will not be published automatically.

When a bin directory is un-published, all the bins and the directories in the bin directory are
un-published.
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9.6. Bin Rules

9.6.1. What is a Bin Rule
A bin rule is a set of criteria that automatically makes a reference to clips, playlists, or
timelines to a certain bin when they are created.

A bin rule is defined for a certain bin. It can be defined for clips, playlists and/or timelines.
Bin rules automatically apply to all new elements upon creation. They can also be applied
to previously created elements, if so desired.

Bin rules do not remove clips from the bin if they no longer meet the bin rule. The process
is only for placing clips into the bin.

9.6.2. How to Define a New Bin Rule
With a basic bin rule, you can select a target or a nearline destination to send new clips or
playlists to or you can request new clips to be automatically protected.

To define a new bin rule, proceed as follows:

1. Right-click the bin for which you want to define a bin rule.

The Bin contextual menu is displayed.

2. Select Bin Rules > Create Bin Rules.

The Bin Rules window opens. See section "Bin Rules Window" on page 74 for a
detailed description of the window.

3. Select the tab corresponding to the items you want the bin rule apply to (Clips /
Playlist).

4. You can

◦ Define a post process by selecting the target/nearline destination where you want
to automatically send new items.

So, when creating a clip or playlist, if you request to send the new item to the bin
for which the post process has been defined, it will automatically be sent to the
target selected in the Bin Rules window.

◦ Select theProtect Clip when inserted in bin option.

So, new clips sent to the corresponding bin will automatically be protected. This
option is not available for playlists.

5. Select the range of dates between which the bin rule must be applied in theValidity
from andValidity until fields.

The selected post-process will automatically be applied to clips or playlists that will be
copied to this bin.
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9.6.3. How to Use a Filter to Define a Bin Rule
You have the possibility to use a search filter of your choice to define a bin rule. This filter
criterionmay be combined with a post process criterion explained in the previous section.
To do so, proceed as follows:

1. Apply a filter with Quick Text Search or Grid Filters.

See section "Searching the Database" on page 84 for details.

2. Right-click the bin

3. Select Bin Rules > Set Current Filter as Bin Filter from the contextual menu.

The Bin Rules window opens. See section "Bin Rules Window" on page 74 for a
detailed description of the window.

4. Select the Clips / Playlist / Timeline tab to check the Condition summary.

5. (optional) Select theApply bin rule filter to existing clips option if you want the
new rule to apply to existingmaterial.

This is only available for clips, not for playlists or timelines.

6. Set thePost Process options, if desired.

7. Set theValidity dates for the bin rule.

8. Click theSave button.

The clips, playlists or timelines that match the rules you have defined, will now
automatically be copied to this bin.

9.6.4. How to Modify an Existing Bin Rule
Tomodify an existing bin rule, proceed as follows:

1. Select a bin in the tree structure.

2. Right-click the bin.

3. Select Bin Rules > Modify Bin Rules from the contextual menu.

The Bin Rules window opens.

4. Select the Clip, Playlist or Timeline tab, depending on which elements the rules
should bemodified for.

5. Make your modifications.

6. Click theSave button.
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9.6.5. How to Apply an Existing Bin Rule
To apply an existing bin rule, proceed as follows:

1. In the tree structure, select the bin for which a bin rule has been defined.

2. Right-click the bin.

3. Select Bin Rules > Load current bin filter and then the item type (Clips, Playlists,
Timelines) from the sub-menu.

The filter defined in the bin rule is applied to the bin.

9.6.6. How to Delete an Existing Bin Rule
To delete an existing bin rule, proceed as follows:

1. Select a bin in the tree structure.

2. Right-click the bin.

3. Select Bin Rule > Delete Bin Rules from the contextual menu.

The Delete Bin Rules window opens:

4. Click Yes to confirm.

IPDirector - Version 6.00 - User Manual - Database Explorer

9. BinsView 73



9.6.7. Bin Rules Window

Overview

The Bin Rules Window contains three tabs: Clips, Playlists and Timelines.

Filter Rules Area

Condition Summary: indicates the search filter applied to the Database Explorer grid
which can be defined as a bin rule.

Apply bin rule filter to existing clips checkbox: when selected, the bin rule will be
applied to all the existing clips present on the network. All the clips will be copied to the
bin.

Clear This Filter button: clears the filter for the selected tab only. This allows clearing a
clip filter and keeping a playlist or timeline filter.

Post Process Area

This is not available for Timelines.

Send to tree: displays all the targets, as available in the Save Clip window (from the Clips
tab), or all the files and Xedio targets (from the Playlists tab).

Backup to Nearline tree: displays all the nearline directories (for Clips and Playlists).
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Protect Clip when inserted in bin checkbox: automatically protect the clip when it is
sent to the bin.

Clear Post processes button: clears the Post Processes defined for the selected tab
only. This allows clearing a clip post process and keeping a playlist or timeline post
process.

Validity Area

The validity dates specify from and until when the bin rule will be applied. The clips,
playlists or timelines matching the bin rules will not be copied to the bin the day before the
Validity from [date] field and no longer be copied after the day specified in theValidity
until [date] field.

The default Validity from [date] is set to the current day and the default validity period is
one day.

Depending on the validity dates for the bin rule, different icons will be displayed in the tree
view, next to the bin:

Bin Rule Icon Meaning

(blue) A filter rule is set but it is not yet active as the Validity from [date] is
later than the current day.

(white) A filter rule is set and is active and the Validity until [date] is later than
the current day.

(red) A filter rule is set and is active and will expire at the end of the current
day.

( blue) A post-process condition is set but it is not yet active as the Validity
from [date] is later than the current day.

( green) A post-process condition is set and is active and the Validity until
[date] is later than the current day.

(red) A post-process condition is set and is active and will expire at the end
of the current day.

Icons may be combined as follows if a filter rula and a post-process condition have been
set: , , .

The validity date is calculated against the current date and time as defined on the EVS
video server. This is displayed in the top right corner of the IPDirector main window.
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10. Logs View

10.1. Introduction

The logs section of the Database Explorer allows you to browse for logs of any event for
which a log has been created. Then you can use the search features to filter the data.

Logs are displayed in the Database Explorer grid with the highlighted color which has been
associated to the log at creation in IPLogger.

The log view can be expanded thanks to a small arrow at the beginning of each line in the
grid to display log entries, Protect Media clips and associated clips.

Refer to the chapter on IPLogger in part 2 of the user manual for more information.

10.2. Logs Tree Structure

10.2.1. Introduction
You can build and customize the Logs tree structure, by adding and organizing directories.

The Logs tree structure displays directories youmay have created as well as the
logsheets which have been created with IPLogger.

You can take advantage of the log directories by searching all logsheets contained inside
the directory. This allows a search across a range of logsheets instead of all sheets in the
system.

Note
If you have selected a directory in the logs tree structure, the system will disable
the Automatic Refresh option for the time being. This is to minimize wasteful
database query updates on the browser window.
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10.2.2. Logs Tree View Elements
The table below mentions which elements are displayed in the Elements grid.

Tree Branch /
Sub-Branch

Description

Logs It displays all the logs. Sub-branches are displayed for each logsheet
and for any log directory which have been created. Expanding the
Logs view displays the log directories and the logsheets created from
IPDirector.

Log directory: shows all the logs from all the logsheets which are in the
selected directory.

Logsheet: shows all the logs which are in the selected logsheet.

Logsheet of which all the logs are protected.

Logsheet of which some of the logs are protected.

Logsheet of which none of the logs is protected.

Logsheet which has been de-activated.

10.3. Log Event Columns

The log event information is organized in columns in the Database Explorer grid. The
following table describes the contents of these columns:

Column Name Description

DEFAULT COLUMNS

T/C Timecode when the event was entered in the log.

Description Description of the event as entered upon creation.

Level A rating can be given to a log, from no stars to three stars. This can
be done at any time and can provide a useful search criterion for use
in the Database Explorer.

Color Color given to the log at creation in IPLogger, if any.

Keywords The first five keywords associated with this logsheet.

Participants Participant keywords associated with this logsheet.

Parent
keywords

Keywords defined in the logsheet properties and therefore common
to all the logs of the logsheet.

Parent
Participants

Participant keywords defined in the logsheet properties and therefore
common to all the logs of the logsheet.
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Column Name Description

ADDITIONAL COLUMNS (alphabetically)

Log Date Date as defined when the logsheet was created.

Log LTC LTC timecode.

Log LTC Date LTC date.

Log USER T/C User timecode.

Log USER T/C
Date

Date according to the user time code.

Associated
Clips

The clips that contain the log T/C and that have beenmade on the
relevant recorders for the logsheet.

Event Name Name of the logsheets defined when it was created.

Event
Description

Free text entry, description added by user.

Event Date Date of the event for which the log was created.

Published User groups (if any) to which the log has been published.

Owner Owner/creator of the logsheet.

Tape ID Identifier of the tape that contains thematerial.

Profile If a Metadata Profile has been defined with user fields and automatic
keywords for a logsheet, a columnwill appear for every user field and
automatic keyword.
These columns are not displayed if a logging profile has not been
selected for the logsheet.

10.4. Contextual Menus

10.4.1. Log Branch and Log Directory Contextual
Menu
Contextual menus are available when you right-click the Logs branch or a log directory in
the Tree view.

Command Description

New
Directory

Creates a new log directory. You can create sub-directories in the same
way.

Rename
Directory

Renames a new log directory.

Delete Deletes a log directory from the EVS video server and the database.
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Command Description

Publish Opens the Publish window in which you can specify the user groups the
selected log directory should be published to.
The log directory will be published to the selected groups providing that
they have the adequate rights.
If the Publish action is done from a directory, all logsheets present in this
directory and its sub-directories will be published to the selected user
groups.

Properties Displays the log directory properties: owner, user groups to which a log
directory has been published,…

10.4.2. Logsheet Contextual Menu
A contextual menu is available when you right-click a logsheet in the Tree view.

Command Description

Export Opens the Export a Logsheet window from which you can browse for the
destination folder, select the desired file type and enter a file name. .
A logsheet can be exported either in XML or in text format (CSV).

Export
current
logging
profile

Opens the Export Profiles window from which you can browse for the
destination folder, select the desired file type and enter a file name.
A logging profile used with a logsheet can be exported in XML format.

Deactivate
logsheet

Deactivates a logsheet. This can be done when the logsheet is completed
to improve the performance of the system. Once de-activated, a logsheet
cannot bemodified and cannot be associated to clips. This permits to
reduce the network load and database activity.
Refer to the IPLogger chapter for more details.

Reactivate
logsheet

Re-activates a logsheet which has previously been de-activated.

Delete Deletes a logsheet from the EVS video server and the database.

Enter TC
Offset

Opens the Enter Logsheet Offset window from which you can set a
timecode offset when logs and clips have been created on different
machines, with different timecode values. Refer to the IPLogger chapter
for more details.

Publish Opens the Publish window in which you can specify the user groups the
selected logsheet should be published to.
The logsheet will be published to the selected groups providing that they
have the adequate rights.

Properties Displays the logsheet properties: owner, user groups to which a log
directory has been published,…

IPDirector - Version 6.00 - User Manual - Database Explorer

10. LogsView 79



10.5. Creating Clips Automatically from a Log
Entry

Introduction

A clip can be automatically created around a log timecode on the record train selected as
the preview recorder or on all relevant recorders.

Prerequisite

PreMark and Post Mark durations must have been set via theAutomatic Clip Creation
based on Logs setting in the Tools > Settings > Clips > General category.

How to Create Clips Automatically from a Log Entry

To automatically create a clip based on a log entry, proceed as follows:

1. Select the log line in the Database Explorer Elements grid.

2. Drag the log entry onto a bin in the Database Explorer tree or onto an open Bin
window.

A clip is automatically created with a duration the duration between the clip IN point and
the log timecode corresponding to the set PreMark and the duration between the log
timecode and the clip OUT point corresponding to the set Post Mark.

You can create a clip on all relevant recorders in one single drag & drop operation by
holding theSHIFT key on the keyboard.

If you hold theCTRL key during the drag & drop operation, the Save Clip window is
opened. Then you can name the clip and associate metadata.

80 10. LogsView

EVSBroadcast Equipment S.A. - November 2012 Issue 6.00.B



11. Media Files View

11.1. Introduction

Themedia files are the files which have been stored on the nearline. They can be on-line,
when the physical storage (IP drive or XFile drive) is still present. They are called "off-
line", when the physical storage where they have been stored has been removed and is no
more present. However, the IPDirector keeps all the information related to these off-line
files to enable an easy retrieval of the required files.

See section "NearlineManagement" on page 21 for major details about the nearline.

11.2. Media Files Tree Structure

TheMedia Files branch can be viewed only by administrators/media managers or, in hi-lo
mode, by hi-lo browsers with appropriate user rights, provided that they first enable the
Show Media Files Plugin from the List View contextual menu.

The purpose of this branch is to perform file management operations: delete, copy, move,
…

Within theMedia Files tree structure of IPDirector, sub-branches are available for on-line
media files and for off-linemedia files.

Clicking theMedia Files branch of the tree displays on-line hi-res and lo-res media files as
well as off-line hi-res and lo-res media files in the Database Explorer grid.

They are listed with full file name, file extension and full path of their physical storage
location.

Each line can be expanded in the Elements grid by using a small arrow at the beginning of
each line.
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11.3. Media Files Data Columns

Themedia files information is organized in columns. Some of the details can be edited
from here, others are for viewing only. All the headings can be used as filters when
performing a search.

Note
See section "Organizing Columns" on page 13 for details on how to hide or show
the columns.

Most of the columns are the same than for Clips. See section "Clip Data Columns" on
page 26. Differences are listed in the table below.

Column Name Description

File Name

Full Path Full path of the file storage location with, e.g. IP address and
machine identification.

File Wrapper Such as EVS MXF QTMov, OP1A,…

Metadata Source Indicates themetadata source for the import: None, EVS MXF or
XML.

Hi-Lo Indicates whether the clip element is hi-res or lo-res.

Import Status Indicates whether the import has been conducted successfully or
unsuccessfully.

Error Message Mentions eventual error messages in case of unsuccessful
import.

Nb Audio Tracks How many audio tracks the clip has.

Video Format Shows the video format of the clip:
PAL SD 625i, PAL HD 1080i, NTSC HD 1080i, …

Video Codec Shows the video codec of the clip:
DNxHD, MPEG2 i-frame,…

Video Bitrate Shows the video bitrate of the clip: from 20 to 360.

Aspect Ratio 4:3 Letter Box, 4:3 Box, or 16:9

Audio Type Mono, Stereo, Dual Stereo, 8 tracks.
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11.4. Media Files Contextual Menu

Different contextual menus are available.

When you right-click a file from the collapsed view of the element list, theMedia Files
Contextual menu is displayed. It gives access to the actions that can be performed on
files from the Database Explorer.

TheRe-Scan XML Metadata option is used in case the import of metadata from the XML
file has been unsuccessful and you want to scan the XMLmetadata file again.

When you right-click a line in the expanded view of the element list, the Clip contextual
menu is displayed. It is the samemenu as the one obtained from the Clip branch of the
tree. See section "Clip Contextual Menu" on page 30 for a detailed description of the
different options available.
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12. Searching the Database

12.1. Search Types

When the database contains large amounts of data, it may become difficult to find a
specific element. The Database Explorer offers several tools to restrict the list of
elements displayed in the Element grid and speed up your search:

• Branch selection in the Tree view - Select a branch of the Tree view to limit the list to
some item types.

• Quick text search - Enter free text in theQuick Text Search field to perform a search
on a specific string.

• Quick timecode search – Enter a timecode value in theQuick Timecode field to
perform a quick search on a specific timecode.

• Advanced search filter – Enter specific criteria in the grid filters to perform a search on
a specific metadata of the elements.

• clips not present in a selected playlist

These search tools are explained in detail below.

All these search tools can be combined.

An applied filter can be saved for later use. Such a saved filter can then be applied in one
click.

A search can also be facilitated by ordering the Elements grid. See section "Element Grid"
on page 12 for more information.

12.2. Branch Selection in the Database Tree

The Database Explorer is presented in a tree structure, much likeWindows Explorer.

The Tree view allows browsing and performing search in the database and the nearline.
By browsing the tree structure, a selection is made and displayed in the Element grid.
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When other search tools (Quick TC Search, Quick Text Search, Grid Filters or Saved
Filters) are already applied, these are then limited to the selected branch.

12.3. Quick Timecode Search

12.3.1. Purpose and Context of Use

TheQuick timecode search allows searching on a timecode value, associated or not with
a date value, to find this value in the elements displayed in the list.

TheQuick timecode searchmay be conducted on clips, clip elements, logs andmedia
files, but not on playlists nor timelines.

Timecode values taken into account for the search are:

Tree plugin Timecode values

Clips Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

Clip Elements Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

Logs TC – range ≤ TC < TC + range

Media Files Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

The system performs a search for all the elements which contain the specified timecode
value, among the elements displayed in the Database Explorer grid.

12.3.2. Quick Timecode Search Field Display
To display or hide theQuick TC Search field, click the small arrow next to theSearch
button and select Display Timecode Search orHide Timecode Search from themenu

If you right-click theQuick TC Search field, a contextual menu allows you to select either
Timecode or Timecode and date to perform your search.
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With Timecode and date, a right-click on the date displays a calendar for date selection.

The TC search is performed only on timecode if the field displays TC only.

The search is performed on timecode and date if the field displays TC and date.

12.3.3. How to Perform a Quick Timecode Search
To perform aQuick TC Search, proceed as follows:

1. Select the tree branch you wish to perform a quick search on.

2. Show the columns you wish to perform a quick search on.

3. Click in theQuick TC Search field.

4. Enter a timecode value in theQuick TC Search field.

5. Press ENTER to apply the Quick TC Search on the selected Database Explorer
branch.

TheQuick TC Search is applied and the search result is displayed in the grid.

6. To clear the applied Quick TC Search, click theX button to the right of the search field

or click theClear All button to clear all filters on the Grid Filter bar and/or from
theQuick search options.

A Quick Timecode searchmay be combined with a Quick Text search. In this case, both
conditions must bemet to give a result in the grid.

12.4. Quick Text Search

12.4.1. Purpose
TheQuick Text Search is used to perform a search based on free text entered in the
Quick Text Search field. This field is available on the top of the Database Explorer grid:

See section "Quick Text Search Area" on page 10 for the description of the buttons
associated to theQuick Text Search field.

Users can enter a search string in one of the three following ways.

• They enter the search string in full in theQuick Text Search field.

• They click the arrow next to theQuick Text Search field, so the last 10 searches are
displayed, and they select one of them.

• They start typing a search string in theQuick Text Search field, so the Autocomplete
function displays a list of proposals, and they can select one of them.

A Quick timecode searchmay be combined with a Quick text search. In this case, both
conditions must bemet to give a result in the grid.
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12.4.2. Search on Displayed / All Columns

Search on Displayed Columns

By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the Elements grid. You can add other columns to the Elements
grid view by right-clicking the grid header and selectingOrganize from the contextual
menu.

Search on All Columns

To activate theSearch on All Columns option, click the small arrow next to theSearch
button and select Search on all columns from the contextual menu:

When this search function is active, theSearch button is highlighted:

or .

Then you can perform the search in theQuick Text Search field as usual.

To deactivate the option, select again theSearch on all columns option.

Note
When theSearch on All Columns option is activated, the search process may
be slower.

Warning
If you perform a Search on all columns without having displayed all the columns,
you will not be able to identify in which column the search string has been found.
For the sake of clarity, it is recommended to display all columns when you
perform a Search on all columns.

12.4.3. Search for Synonyms
Users have the possibility to perform a search for word synonyms, provided that they
have been defined in the SQL thesaurus file and that the corresponding option has been
set in the General setting Freetext searches behavior.

Then, a search performed with a search string will return the predefined synonyms as
well. This function can be used to search for translated words.
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12.4.4. Quick Text Search Field Display
The following table shows the various displays for the Quick Text Search field, and what
they mean:

Display Meaning

The field background is white:
NoQuick Text Search is entered or applied or
entered.

The field background is red:
The user is typing or has typed a search string, but
has not applied it yet.

The field background is green:
The user has applied the search string, by pressing
ENTER. The result of the Quick Text Search is
displayed in the grid.

The down arrow next to theQuick Text Search field
gives access to the last 10 searched strings.

12.4.5. Quick Text Search Syntax Rules
TheQuick Text Search option obeys specific rules which can be accessed via theHelp

button next to theQuick Text Search field: .
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The string that you enter in theQuick Text Search field is analyzed according to the
following set of rules:

Search String Search Result Logical Equivalent

Yellow card Searches for the words yellow and card, even if
in two different fields (columns), for example
yellow in Name and card in Keywords.
For example a clip named "The Yellow Man"
with keywords "Red Card" will be found, since
it has yellow and card in 2 different fields.

"Yellow" AND "card"

Yellow | card Searches for yellow or card, even if in two
different fields (columns), for example yellow in
Name or card in Keywords.

"Yellow" OR "card"

"Yellow card" Searches for exact matches of Yellow card. 
Between the quotes, all characters are
considered as characters and not operators or
wildcards.

"Yellow card"

card* Searches for card at the beginning of a word.  "card"*

*card* Searches for all words that include card. *"card"*

-card Searches for fields which do not contain the
word card.

=card Searches for a whole field that contains only
card.
For example, if a field contains yellow card, the
=card condition will not return any result.

Search operators may be combined. For example, a space followed by "-" means AND
NOT.

12.4.6. Autocomplete Function

Introduction

The Autocomplete function is a help service for the capture of search string.

As soon as the users start typing in theQuick Text Search field, the Autocomplete
function provides a list of matching words and sentences known by the system and
containing a word beginning with the typed letters.
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Warning
Make sure the IP API service is started to be able to use the Autocomplete
function.

Autocomplete List

The list displayed below theQuick Text Search field is made up of different types of
results, as described in the following table.

Icon
Description :

The line displays the result corresponding to the typed letters and …

…coming from the local search history. Several lines can be displayed, themost
recent are shown on the top of the list.

… coming from the 100most popular searches asked to the system since its
startup, and launched from the same tree branch. Several lines can be displayed,
themost frequent are shown on the top of the list.

… coming from an index of words entered in text fields, such as item name, item
source name, item VarID, tape ID, itemmetadata text. Keywords are not
indexed in this list. Several lines can be displayed, sorted alphabetically.

… corresponding to a keyword from a keyword list.

… corresponding to a participant from a keyword list.

The proposals made in the Autocomplete list for the last search, popular search and
indexed words depend on the tree branch selected at the time when a word is typed. For
example, if the Clips view is selected in the Database Explorer tree view, only the
searches performed on the Clips view will be proposed, as well as indexed words
attached to clips.

Proposed keywords and participants are not linked to the selected tree branch.

How to Perform a Quick Text Search with the
Autocomplete Function

To perform aQuick Text Search, proceed as follows:

1. Select the tree branch you wish to perform a quick search on.
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2. Show the columns you wish to perform a quick search on.

3. Type a search string in theQuick Text Search field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

4. Select a line by using themouse or the key.

5. Press ENTER.

The search is launched with the selected proposal on the selected Database Explorer
tree branch.

The search results are displayed in the grid.

6. To clear the applied Quick Text Search, click theClear QTS button to the right
of the search field.

To clear all the filters applied, from any search option, click theClear All button.

To perform a search based on two words, proceed as follows:

1. Follow steps 1 to 4 from the previous procedure.

2. Press and then start to type a second word.

A new list of proposals is displayed based on the second word.

3. Select a line by using themouse or the key.
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4. Press ENTER.

The search is launched with the two selected proposals on the selected Database
Explorer branch.

12.5. Advanced Search

12.5.1. Purpose and Context of Use
The Advanced Search Filters are available for more detailed search operations. They
allow searches on a specific column of the grid.

To display, or hide, the Grid Filter bar, click theShow/Hide Grid Filter Bar button over
the grid.

TheGrid Filter bar is displayed with a field above each column in the Elements grid.

12.5.2. Advanced Search Fields Types
Different types of search fields exist:

• free text fields: search data can be entered directly in these fields.

◦ in most of the cases, no button is available next to the field, e.g. Name field.

◦ Keywords and Participants search fields

• field with an option list: an arrow giving access to a list of options is available on the
right of the field, e.g. Level field.
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• field with a complex filter button on the right of the field giving access to a Select Filter
Condition window to define specific search values, e.g. Status field, Keywords field,
…

12.5.3. Search in Free Text Fields

Autocomplete Function

The Autocomplete function is a help service for the capture of search string. The
Autocomplete function, described in "Autocomplete Function" on page 89, is also enabled
during searches in free text search fields of the grid filters.

The Autocomplete list displayed under free text search fields of the grid filters is limited
compared to the one shown under theQuick Text Search field. No last search or popular
search will be proposed.

• Only indexed words will be listed under free text fields other thanKeywords or
Participants fields.

• Only keywords will be listed under theKeywords field.

• Only participants keywords will be listed under theParticipants field.

Free Text Search Syntax Rules

The string that you enter in the free text field of a grid filter is analyzed according to the
same set of rules as in the Quick Text Search. See section "Quick Text Search Syntax
Rules" on page 88 for details on these rules.

In addition, the "?" operator can be used in the LSM ID column. This means "any
character in place of the ?"

How to Perform a Search through Free Text Grid
Filter Fields

To enter search values in a free text field of a grid filter, proceed as follows:

1. Select the tree branch in the Tree view.

2. Show the columns you wish to perform a search on.

3. Display the Grid Filter bar by clicking theShow/Hide Grid Filter Bar button over the
grid.

4. Type a search string in the field, based on the rules detailed in "Free Text Search
Syntax Rules" on page 93.
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A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

5. Select a line by using themouse or the key.

You can unselect a line by pressing theEscape key.

6. Press ENTER.

The search is launched on the selected Database Explorer tree branch.

The search results are displayed in the grid.

Note
Off-line clips or clip elements are displayed in filters results.

12.5.4. Search in Non-Free Text Fields
Non-free text search fields of the Advanced Search pane give access to an option list to
select a search value or to a Select Filter Condition window to define specific search
values.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Option
List

(e.g.
Level,…)

Click the arrow next to a search field to display the option list for the
corresponding criterion.

Select one or more options.

Confirm your selection with the button or cancel and exit by clicking
the button.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Date Click theComplex Filter button next to aDate field to open the calendar
window.

In this window you can select a specific date or one of the options in the
Last xx pane.
You can also use the logical operators from the right pane to construct a
more complex search condition:
• Select a logical operator on the right
• Select a date
• Select a second date

The search condition is displayed in theCondition field.
• Click OK orCancel.

Note
The NOT operator may be combined with one of the other
operators.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Duration Click theComplex Filter button next to aDuration field to open this
window:

Here you can enter a duration or use the logical operators from the right
pane to construct amore complex search condition.

Timecode Click theComplex Filter button next to a Timecode field to open this
window:

Here you can enter a timecode or use the logical operators from the right
pane to construct amore complex search condition:
• Select a logical operator on the right
• Enter a timecode value
• Click Add. It appears in theCondition field.
• Enter a second timecode value
• Click Add. The whole condition is displayed in theCondition field.
• Click OK.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Number Click theComplex Filter button next to aNumber field to open this
window:

In this window you can enter a number or use the logical operators from the
right pane to construct amore complex search condition.
• Enter a number in the field
• Click Add
• Select a logical operator on the right
• Enter a second number in the field
• Click Add

The search condition is displayed in theCondition field.
• Click OK orCancel.

Note
Operators belonging to different groups may be combined.
• Group 1: AND, OR
• Group 2: NOT
• Group 3: <, >, <=, >=
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Search
Criterion
Type

Option List / Select Filter Condition Window

Clip
Elements

Click theComplex Filter button next to theClip Elements field to open
this window:

Select check boxes depending on whether you want to search for clips
with or without the different element types.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Status Click theComplex Filter button next to theStatus field to open the
window which allows you to filter on the destinations themedia has been
sent to:
• Targets: lists all the targets defined in the remote installer.
• Nearline directories: lists all the nearline directories, as defined in the

remote installer.
• Gigabit copy XTs: lists all the EVS video servers which are part of the

workgroup, as defined in the remote installer.

Note
Icons for destinations targets may have been customized from
the Remote Installer.
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Search
Criterion
Type

Option List / Select Filter Condition Window

Keywords Click theComplex Filter button next to theKeywords field to open this
window:

See section "Search for One or Several Keywords" on page 101.

Note
The NOT operator may be combined with one of the other
operators.

See section "Search for Child Keyword Based on Parent Keyword" on
page 102 for advanced search based on a parent keyword defined in a
dictionary.

12.5.5. Search for One or Several Keywords
To search for some keywords from the Select Filter Condition (Keywords) window,
proceed as follows:

1. Select a Keyword Grid or a Dictionary in the Search For pane, or click in the Search in
Keyword List field.

The selected Keyword Grid or Dictionary, or the Keyword List, is displayed in the right
lower area of the window.

2. Select a keyword.

It appears in the Selected Keywords area and in theKeyword Condition or
Participant Condition field.

Keywords which have been selected are shownwith a different color in the Keyword
Grid, Dictionary or Keyword List.

3. If required, select a logical operator.
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4. Select a second keyword.

The whole condition is shown in theKeyword Condition orParticipant Condition
field.

5. Click OK.

The filter is applied to the Elements grid and the filter condition is displayed in the
Keywords field.

12.5.6. How to Clear a Applied Advanced Search
Filter
To clear a filter applied on an advanced search criterion, click theX button next to the
corresponding criterion:

When filters have been applied from several search tools, all the filters can be cleared by
clicking theClear All button next to theQuick Text Search field:

12.5.7. Search for Child Keyword Based on Parent
Keyword

Context of Use

As explained in the Keywords Management chapter, in part 2 of themanual, child and
parent keywords can be defined in a tree structure into the Dictionary tool.

During an event, you can define all the player names of a football team as child keywords
of the parent keyword "team name" or "country". You can then assign a child keyword to
logs or clips.
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From the Database Explorer, it is thereafter possible to retrieve themedia linked to all the
child keywords of the same parent keyword by using the recursive option.

How to Retrieve Child Keywords

To do so, proceed as follows:

1. In the Database Explorer, select the tree branch you wish to perform a search on.

2. In the grid, show the columns you wish to perform a search on.

3. Display the Grid Filter bar by clicking theShow/Hide Grid Filter Bar button over the

grid .

4. Select theRecursive checkbox from the Keywords advanced search field to perform
a search on all the child keywords linked to the selected parent keyword

5. Click the Complex Filter button displayed in theKeywords column header.

The Select Filter Condition (Keywords) window opens.

6. In theDictionaries field, select the dictionary name.

The keywords from the selected dictionary are displayed in the list.

7. Select the parent keyword on which you want to perform a search.

It is displayed in theKeywords Condition field.

8. Click theRecursive button if you have not selected theRecursive option from the
Keywords advanced search field (step 4).

9. Click OK.
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The list of elements containing a child keyword of the selected parent keyword is
displayed in the Database Explorer grid.

12.6. Clips not in a Selected Playlist

You can easily get the list of the clips which are not present in a selected playlist by
selectingSearch for Clips not in the Selected Playlist from the Playlist contextual
menu.

This opens a second Database Explorer/Clips window which provides the following
buttons:

Button Meaning

(highlighted)

When the button is highlighted, the option is enabled (by default). The list
in the grid displays the clips not present in the selected playlist.
Note that an additional  filter can be applied to the grid from this window,
as explained in sections "Quick Timecode Search" on page 85, "Quick
Text Search" on page 86 and "Advanced Search" on page 92.

(gray)

When the button is not highlighted, the option is disabled. The list in the
grid displays all the clips, even those present in the selected playlist.
Note that an additional filter can be applied to the grid from this window.

highlighted)

When the button is highlighted, it means that at least one filter is active.
All the active filters can be disabled with theCLEAR ALL button.

(gray)

When no filter is active, theClear ALL button is not highlighted.
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12.7. Using Saved Filters

12.7.1. Introduction
Once you have defined filters and search terms, youmay want to save them for later use.
You can then apply the same set of filters with a single click.

Saved filters will be common between:

• the Clips tree and the Clip view in bins

• the Playlists tree and the Playlists view in bins

• the Timelines tree and the Timelines view in bins

12.7.2. How to Save Filters
To save filters, proceed as follows:

1. Define the filters you wish to save, as explained in section "Searching the Database"
on page 84.

2. Make sure the Saved Filters pane is visible under the tree view by clicking the
button.

3. Click theSave Filter button in the Save Filter pane.

The New Filters window is displayed:

4. Enter a name for the applied filters set.

5. Click OK to confirm.

The new filter name is listed in the Saved Filters pane.

12.7.3. How to Apply Saved Filters
To apply a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view by clicking the
button.

2. Select the desired filter(s) in the Saved Filters pane.

◦ Click to select a single filter
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◦ CTRL + click to select multiple filters

◦ SHIFT + click to select a range of filters

3. Click theAPPLY button in the Saved Filters pane.

Your filters are shown in the grid filter bar and/or quick search fields and they are
applied in the grid.

12.7.4. How to Update a Saved Filter
To update a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view by clicking the
button.

2. Select the filter you wish to update in the Saved Filters pane.

3. Click theAPPLY button.

4. Make the desired changes to the filter definition.

5. Right-click the filter name in the Save Filter pane.

A contextual menu is displayed.

6. Select Update from themenu.

7. Click Yes to the confirmationmessage that appears.

The filter is updated.

12.7.5. How to Rename a Saved Filter
To rename a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view by clicking the
button.

2. Select the filter you wish to rename in the Saved Filters pane.

3. Right-click the filter and select Rename from the contextual menu.

The Rename Filters window opened.

4. Enter the new name in theName field and click OK to confirm.

The filter name is updated in the Saved Filters pane.

106 12. Searching the Database

EVSBroadcast Equipment S.A. - November 2012 Issue 6.00.B



12.7.6. How to Delete a Saved Filter
To delete a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view.

2. Select the filter you wish to delete in the Saved Filters pane.

3. Right-click the filter and select Delete from the contextual menu.

4. Click Yes in the confirmation window that appears.

The Saved Filter is deleted from the Saved Filters pane.

12.7.7. How to Publish a Saved Filter
To publish a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view.

2. Select the filter you wish to publish in the Saved Filters pane.

3. Right-click the filter and select Publish.

The Publish window is displayed.

4. Select the group(s) you wish to publish the filter to in the Available groups pane.

◦ Click to select a single group

◦ CTRL + click to select multiple groups

◦ SHIFT + click to select a range of groups

5. Click theAdd button.

6. Click thePublish button.

Note
When a filter has been created with the condition "owner = mine" and saved as a
Saved Filter, you can publish it to selected groups. Then, when the recipient will
apply the filter, the condition "owner = mine" will be applied to himself/herself.
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13. Loading and Playing Media

13.1. Introduction

There are various ways to load or to load and play amedia on a player channel from the
Database Explorer.

The Browse and Play modes help to perform those actions from a single-click. They are
available from theBrowse, Play andAuto-Play buttons located on the toolbar:

To be able to use thesemodes and automatically play an element or a list of elements
from the Database Explorer, a player channel must have previously been assigned to the
Database Explorer.

13.2. Assigning a Player Channel to the
Database Explorer

13.2.1. How to Assign a Player Channel from the
Channel Explorer
1. Open the Channel Explorer and the Database Explorer.

2. In the Channel Explorer, select the player channel to assign to the Database Explorer.

3. Drag the selected player channel to the Database Explorer window and drop
anywhere.

The player channel is displayed in this field.

All actions requesting an association to a player channel, for example the Browse, Play
and Auto-Play functions, will be performed on the assigned player.

13.2.2. How to Assign a Player Channel from the
Status Bar of the Database Explorer
Alternatively, you can right-click the Associated Channel zone on the right of the Status
bar and select the desired channel from this menu:
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Depending on the EVS server configurations, up to 6 player channels per server are
available.

If the workstation has a valid license for the OCX Software Player, and the user has it
visible currently, it will also be an option to select as a defined DB Explorer channel.

13.3. Loading Media

13.3.1. On the Player Channel Associated to the
Database Explorer
To loadmedia from the Database Explorer on a channel previously assigned to the
Database Explorer (as explained in "Assigning a Player Channel to the Database
Explorer" on page 108), proceed in one of the following ways:

• Click the Browse button to activate the Browsemode.

The button becomes highlighted.

• Use the Browsemode of the BEPlay Remote device. Refer to section "BEPlay
Remote" in part 1 of the user manual for more details.

OR

• Double-click an element line in the database explorer grid. This works would the Play

mode be active or not.

The element is loaded on its first frame on the associated channel.

The corresponding element line in the database explorer grid is highlighted in dark green.

Note
Nothing happens when trying to browse an off-line file.
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13.3.2. On the Player Channel Associated to the
Control Panel
As explained in the chapter describing the Control Panel module, it is possible to load
media from the Database Explorer to the Control Panel by a drag-and-drop operation. This
does not require the association of a player channel to the Database Explorer. Themedia
is then loaded on the player channel assigned to the Control Panel.

Note
At that point, you will have the possibility to play themedia by

• pressing thePlay shortcut key to play the element
OR
• clicking thePlay button on the Control Panel if the channel assigned to the

Database Explorer is also assigned to an opened control panel.

13.4. Playing Media

13.4.1. Introduction
There are several ways available to play media on a channel from the Database Explorer:

• Load as explained in "LoadingMedia" on page 109 and play by pressing the shortcut

key or clicking thePlay button on the Control Panel.
• Immediately play on the channel assigned to the Database Explorer.

• Immediately play on the channel assigned to the Control Panel.

Note
Nothing happens when trying to play an off-line file.

13.4.2. How to Load and Immediately Play an
Element
To play the element on the channel associated to the Database explorer, proceed as
follows:

1. Assign a channel to the Database Explorer as explained in "Assigning a Player
Channel to the Database Explorer" on page 108.

2. Click thePlay button to activate the Play mode.

The button becomes highlighted.

3. Click an element line in the Elements grid.
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The element immediately played out on the channel associated to the Database
Explorer.

The corresponding element line in the Elements grid is highlighted in dark green.

To play the element on the channel associated to a control panel, proceed as follows:

1. In the Database Explorer, select the line corresponding to the element you want to be
played out.

2. Press CTRL key and, still holding it, drag the element line to the Control Panel.

The element is immediately played out on the channel associated to the Control
Panel.

Note
The Play mode is not recommended when selecting elements to play for live
transmission as there will be a delay between the loading of the element and the
playout.

13.5. Playing a List of Elements

13.5.1. How to Load and Immediately Play a List of
Elements
Before playing elements in Auto-Play mode, you need to ensure that a player channel has
been assigned to the Database Explorer. See section "Assigning a Player Channel to the
Database Explorer" on page 108 for more information on this.

To start playing elements in Auto-Play mode, proceed as follows:

1. In the Database Explorer, open the Clips or Clip Elements branch from where you
want to play elements in Auto-Play mode.

2. Click theAuto-Play button on the toolbar.

Auto-Play mode is activated and the button becomes highlighted.

3. Click the first element from where you want to play in Auto-Play mode.

The element is directly played on the player that is assigned to the Database Explorer.
Then all the subsequent elements in the Database Explorer window are played in the
displayed sequence until the last element of the list is finished.

The element being played out is highlighted in dark green in the Database Explorer grid
and the next element is in light green.

Note
If playlists or trains are included in a list of elements on which the Auto-Play
mode is applied, they will be skipped.
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13.5.2. Modifying the Playout Sequence in Auto-Play
Mode
Various transport functions are available in Auto-Play mode, to shift the Auto-Play order to
an element that is not the next one in the sequence.

The following transport functions can be executed:

Preload an element Double-click an element in the Database Explorer to preload
it on the player channel.
Then press thePlay shortcut key (P) to play the element.

Load & play an
element immediately

Select an element to load on the player channel and play
immediately.

Load & play an
element after the
current one

Pressing theCTRL key while clicking an element plays the
selected element after the current one is played out.

13.5.3. Using Auto-Play Mode in Several Database
Explorer Windows
You can open several Database Explorer windows and use them in Auto-Play mode with
the same player channel or with different player channels assigned.

If different players are assigned, they will be considered as independent from each other.
Using the Auto-Play mode in one of the windows will not affect the second Database
Explorer window.

If the same player is assigned, the Database Explorer window onwhich the Auto-Play
mode has been used last is considered as themaster window. It has the lead over the
player channel.

Using two Database Explorer windows assigned to the same player channel leads to the
following possible situations:

• When the operator performs a search on themaster Database Explorer window, the
current element is played out and the first element of the search results is
automatically chained.

• When the operator performs a search in the secondary Data Explorer window, this
does not impact the Auto-Play in themaster window. The operator needs to activate
the Auto-Play to take the lead over the player channel and start playing the elements
in Auto-Play mode.
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14. Database Explorer Shortcuts

Some commands in the Database Explorer can be accessed from the keyboard.

Database Explorer shortcuts available from IPDirector are:

To view or customize the keyboard shortcuts, proceed as follows:

1. Click Tools > Define Shortcuts in themain IPDirector toolbar.

This opens the Define Shortcuts window.

2. Click the Database Explorer button on the left to go to the relevant section:
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3. You can view the available shortcuts here.

4. To change a shortcut: select it and press the desired key combination.

5. Click OK to save your changes.
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